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ВВЕДЕНИЕ 
 
Целью выполнения лабораторных работ по курсу «Основы компьютер-

ного проектирования и моделирования радиоэлектронных средств» является: 
● углубление и закрепление знаний, полученных на лекционных заня-

тиях; 
● изучение структуры, состава и принципов функционирования систем 

автоматизированного компьютерного проектирования для разработки и ис-
следования радиотехнических устройств; 

● получение и закрепления навыков по проведению математического 
моделирования и вычислительных экспериментов по заданной программе с 
использованием программных пакетов САПР; 

● формирование умений интерпретировать результаты компьютерного 
моделирования и принимать решения по оптимизации параметров и характе-
ристик РЭС; 

● закрепление навыков работы на ЭВМ. 
 

Используемое оборудование и программное обеспечение 
 
Лабораторные работы проводятся в учебном классе, оснащенном пер-

сональными компьютерами или специализированными рабочими станциями, 
с установленными программами позволяющими проводить схемотехниче-
ское моделирование РЭС. Предпочтительно использование программных па-
кетов применяемых на производстве при проектировании РЭС. 

Данное учебно-методическое пособие, прежде всего, ориентировано на 
использование в качестве программного средства САПР РЭС семейства про-
грамм Cadence OrCAD версий 9.1-16.3 работающих на платформе OS Win-
dows. Для освоения лабораторного практикума достаточно демо-версии па-
кета OrCAD. 

Программа схемотехнического моделирования PSpice входящая в состав 
пакета OrCAD, как и большинство существующих программ-имитаторов в этой 
области, основана на системе моделирования SPICE. Принципы и приемы 
SPICE-моделирования используемые в OrCAD справедливы для любых SPICE-
подобных и SPICE-основанных систем моделирования входящих в состав про-
граммных пакетов САПР РЭС, таких как Altium, Proteus, Multisim и др. 

Предполагается, что основные навыки построения схем в редакторе 
OrCAD Capture студентами уже получены самостоятельно или на водных за-
нятиях. 
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 ВВЕДЕНИЕ
Состав, структура и порядок проведения лабораторных занятий 

Состав, структура и порядок проведения лабораторных занятий 
 

Лабораторные занятия проводятся в объеме 18 аудиторных часов в со-
ответствии с графиком учебного процесса и включают выполнение четырех 
лабораторных работ. Подготовка к лабораторным работам, обработка резуль-
татов и оформление отчетов предполагает 12 часов самостоятельной работы. 
Темы лабораторных работ и объем учебной работы приведены в табл. 1. 

 
Таблица 1 

 

Объем учебной работы, час Номер 
ЛР 

Название лабораторной работы 

Аудиторные 
занятия 

Самостоятельная
работа 

1 Статический, частотный и временной  
анализ пассивной линейной RLC цепи 

5 2 

2 Исследование моделей 
полупроводниковых приборов 

6 4 

3 Исследование шумовых свойств 
усилительного каскада на биполярном 
транзисторе 

2 2 

4 Параметрическая оптимизация, анализ 
чувствительности и исследование 
влияния разброса параметров элементов 
на характеристики схемы 

5 4 

 

Каждая лабораторная работа включает ряд этапов: выдача задания, 
подготовка, допуск, выполнение, обработка, оформление, сдача и защита. 

Выдачу задания на лабораторную работу осуществляет преподава-
тель, во время аудиторных часов отведенных на лабораторные занятия. За 
каждым студентом закрепляется вариант, в соответствии с которым опреде-
ляются параметры в конкретных лабораторных работах. 

Допускается, индивидуальное изменение заданий, по согласованию с 
преподавателем и при условии выполнения основных целей указанных в ла-
бораторной работе. 

Теоретическая подготовка к лабораторной работе производится во 
внеаудиторное время и включает: 

● уяснение цели выполнения работы; 
● разбор сущности изучаемого явления и теоретических основ пред-

стоящего эксперимента; 
● проработку инструкции к работе; 
● усвоение последовательности операций при постановке эксперимента; 
● выяснение, какие показания следует фиксировать и какие наблюдае-

мые параметры подлежат регистрации. 
При проработке теоретических вопросов не следует ограничиваться 

только инструкциями к работам, нужно использовать конспекты лекций, 
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учебных пособия и другую литературу по предмету и базовым дисциплинам 
радиотехнического профиля, включая как уже пройденный материал («Ма-
тематика», «Физика», «Информатика», «Основы теории цепей», «Электрони-
ка»), так и осваиваемый параллельно («Схемотехника АЭУ», «Радиотехниче-
ские цепи и сигналы»). 

Необходимо обращать внимание на четкое усвоение терминов, поня-
тий, законов используемых в ходе лабораторных занятий, без этого практи-
ческая работа теряет смысл. 

Некоторые практические части подготовки к лабораторным работам, 
такие как предварительные расчеты, требующие консультации преподавате-
ля, могут выполняться в рамках аудиторных практических занятий или кон-
сультаций. 

Допуск к выполнению лабораторной работы осуществляется препода-
вателем по результатам тестирования (или устного опроса). В ходе допуска 
проверяется готовность студентов к выполнению лабораторной работы, уро-
вень теоретической подготовки, понимание сущности предстоящей работы, 
наличие подготовленных письменных или электронных материалов (таблиц 
для записи экспериментальных данных, заготовок для графиков и т. д.). 

После получения допуска, студент может приступить к выполнению 
лабораторной работы. Все студенты выполняют работу индивидуально, под 
общим руководством преподавателя, и в соответствии с лабораторным зада-
нием и порядком выполнения работы. 

В процессе выполнения задания, студентом, тщательно фиксируются 
(вручную или средствами ПО ПК) все значения контролируемых параметров 
и характеристик, вносимые изменения и производимые действия. По завер-
шению задания преподаватель проверяет полученные студентом результаты 
и фиксирует окончание выполнения лабораторного задания. 

В крайних случаях (из-за болезни и т. п.), поскольку специфика пред-
мета позволяет, то по согласованию с преподавателем допускается выполне-
ние лабораторных заданий в неаудиторное время в компьютерном классе (с 
разрешения обслуживающего персонала) или в домашних условиях на ПК с 
демо-версиями используемых программ. 

После выполнения лабораторного задания студент приступает к обра-
ботке полученных данных и оформлению отчета. Данные этапы могут вы-
полняться студентом как во время аудиторных занятий (при досрочном за-
вершении лабораторного задания), так и во время самостоятельной работы. 
При обработке данных и оформлении приветствуется использование персо-
нального компьютера и соответствующих программных средств (математи-
ческих и офисных) – Word, Excel, Visio, Mathcad, Matlab и т. п. 

Подготовленный студентом отчет проверяется преподавателем и при 
соответствии формальным признакам (правильность оформления и полнота 
содержания), студент допускается к защите, которая проводиться преподава-
телем в форме тестирования или устного опроса по контрольным вопросам. 



 ВВЕДЕНИЕ
Оценивание результатов. Ограничения и требования 

Оценивание результатов 
 
Результаты выполнения студентом лабораторной работы оцениваются 

в рамках кредитно-рейтинговой системы в соответствии с Положением об 
организации учебного процесса ВУЗа с использованием системы зачетных 
единиц. Примерная относительная трудоемкость этапов выполнения лабора-
торной работы приведена в табл. 2. 

Таблица 2 
 

Относительная трудоемкость этапов выполнения лабораторной работы 
 

Этап выполнения 
лабораторной работы 

получение 
допуска 

выполнение 
лабораторного

задания 

оформление 
отчета 

защита 

Коэффициент 
трудоемкости 

0,05 0,15 0,1 0,7 

 

При оценивании по традиционной системе (зачет/незачет), выполнение 
лабораторной работы зачитывается по факту выполнения всех этапов. 

 
Ограничения и требования 

 
Не допускается: 
● защита более одной лабораторной работы за занятие; 
● защита лабораторных работ во время сессии без оснований, заверен-

ных деканатом. 
Лабораторная работа не принимается к защите если: 
● выполненная работа не соответствует варианту; 
● при проверке был зафиксирован факт плагиата (отчет списан); 
● неправильно оформлен титульный лист; 
● отсутствуют пояснения и интерпретация полученных результатов, 

отсутствуют выводы, подробные расчеты, исходные формулы и т. п.; 
● при оформлении отчета допущены многочисленные, грубые нару-

шения стандарта предприятия. 
Лабораторная работа не засчитывается если: 
● студент, по требованию преподавателя, не может продемонстриро-

вать выполнение на ЭВМ любой из использованных при выполнении лабора-
торной работы процедур. 
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 ВВЕДЕНИЕ
Требования к оформлению и содержанию отчетов по лабораторным работам

Общие требования к оформлению и содержанию отчетов 
по лабораторным работам 

 
После выполнения лабораторной работы необходимо подготовить от-

чет по работе, отражающий все этапы подготовки и выполнения лабора-
торной работы и оформленный в соответствии со стандартом ВУЗа. 

Отчет должен содержать: 
● титульный лист, оформленный в соответствии со стандартом ВУЗа с 

указанием: 
- названия ВУЗа, института, кафедры и предмета; 
- номера и названия лабораторной работы; 
- номера группы, варианта, ФИО студента подготовившего отчет; 
- должность, звание, ФИО преподавателя проверяющего отчет. 
● цели лабораторной работы; 
● схемы и параметры анализируемых цепей; 
● исходные соотношения, расчеты и графики, полученные при подго-

товке к выполнению лабораторной работы; 
● результаты, полученные при работе на ЭВМ, оформленные в виде 

таблиц и графиков; 
● обсуждение полученных результатов, выводы по работе. 
 

Использованные источники 
 
При подготовке теоретических разделов лабораторного практикума ис-

пользовались материалы следующих источников: по первой работе – [13, 21], 
по второй – [20, 23], по третьей – [7], по четвертой – [1, 2, 3, 9, 11]. 

При написании основного материала лабораторного практикума ис-
пользовались [3, 5, 6, 10, 12, 16, 18, 22], а также справочная система про-
граммного пакета Cadence OrCAD 16.0. 
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ЛАБОРАТОРНАЯ РАБОТА №1 
Статический, частотный и временной анализ пассивной 

линейной RLC цепи 
 

Цель работы 
 
Приобретение навыков построения и анализа аналоговых схем по по-

стоянному току, в частотной и временной областях с помощью ЭВМ (пакет 
OrCAD). 

 
Основные теоретические положения 

 
Все элементы электрической цепи условно можно разделить на актив-

ные и пассивные. Активным называется элемент, содержащий в своей 
структуре источник электрической энергии. К пассивным относятся элемен-
ты, в которых рассеивается (резисторы) или накапливается (катушка индук-
тивности и конденсаторы) энергия. К основным характеристикам элементов 
цепи относятся их вольт-амперные, вебер-амперные и кулон-вольтные харак-
теристики, описываемые дифференциальными или (и) алгебраическими 
уравнениями. Если элементы описываются линейными дифференциальными 
или алгебраическими уравнениями, то они называются линейными, в про-
тивном случае они относятся к классу нелинейных. Строго говоря, все эле-
менты являются нелинейными. Возможность рассмотрения их как линейных, 
что существенно упрощает математическое описание и анализ процессов, 
определяется границами изменения характеризующих их переменных и их 
частот. Коэффициенты, связывающие переменные, их производные и инте-
гралы в этих уравнениях, называются параметрами элемента. 

Электрическая цепь называется линейной, если она состоит из эле-
ментов, у которых зависимость между током и напряжением, током и пото-
косцеплением, зарядом и напряжением линейная, т. е. такая цепь состоит 
только из линейных элементов. В противном случае электрическая цепь на-
зывается нелинейной. 

Для линейных цепей законы Кирхгофа записываются в виде системы 
линейных уравнений, в результате решения которой определяется режим ра-
боты электрической цепи. Для расчета сложных линейных электрических 
цепь применяются методы: контурных токов, наложения, эквивалентного ге-
нератора и др. В программе PSpice как и большинстве программ автоматизи-
рованного моделирования электрических цепей используется метод основан-
ный на методе узловых потенциалов). 

Различают электрические цепи постоянного и переменного тока, среди 
последних, наиболее распространены цепи гармонического тока. В них ЭДС и 
токи представляют собой синусоидальные функции времени одной частоты. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Основные теоретические положения

В моделирование электрических цепей выделяют ряд задач, среди ко-
торых одни из основных: анализ по постоянному току, анализ временных от-
кликов и анализ частотных свойств цепи. 

Программа OrCAD PSpice позволяет проводить все три типа анализа. 
Bias Point – анализ цепи по постоянному току в рабочей точке. Bias 

Point – точка смещения. Анализ по постоянному току позволяет получать ха-
рактеристики схемы: токи, напряжения и рассеиваемые мощности. Все на-
пряжения, вычисляемые PSpice, являются напряжениями между отдельными 
точками схемы и одной опорной общей точкой, местоположение которой за-
дается пользователем. 

AC Sweep – анализ по переменному току. АС – alternating current –
 переменный ток. Sweep – вариация, изменение. Свип-сигнал – это колебание 
постоянной амплитуды с непрерывно меняющейся частотой. 

Анализ по переменному току позволяет анализировать частотные от-
клики схем, производить построение амплитудно-частотных и фазо-
частотных характеристик схемы для токов, напряжений, мощностей и т. п.. 
Анализ производиться при наличии в схеме источников имеющих в своих 
параметрах атрибут AC или ACMAG, таких как источник переменного тока 
IAC или источника переменного напряжения VAC, для которых указывают-
ся амплитудное значение переменной составляющей и величина постоянной 
составляющей (в частном случае может быть принята равной нулю). При 
анализе задаются минимальное значение частоты, максимальное значение 
частоты, и для линейного шага по частоте – общее число точек, а для лога-
рифмического – число точек на декаду или октаву. 

Time Domain (Transient) – анализ переходных процессов. Time Do-
main – временная область, а transient – переходной. 

Анализ переходных процессов позволяет получать значения характери-
стик схемы (токов, напряжений, мощностей и т. д.) при переходном процессе. 
Анализ переходных процессов всегда начинается с момента времени t  0. 
Указывается время окончания анализа переходного процесса (Run to time) и 
максимальный шаг интегрирования (Maximum step size). Если требуется ин-
формация о переходном процессе с момента времени t  0, это время задается 
(Start saving data after), при этом обеспечивается получение графической ин-
формации с заданного момента времени, хотя сам анализ осуществляется с 
момента времени 0t  . При анализе указывается параметр, определяющий 
режим расчета начального приближения по постоянному току (Skip the initial 
transient bias point calculation). По умолчанию он выключен, и анализ по по-
стоянному току автоматически предваряет анализ переходных процессов. Ре-
зультаты анализа по постоянному току в этом случае являются начальными 
значениями переменных при анализе переходных процессов. В случае отклю-
чения этого параметра за начальные значения принимаются токи в индуктив-
ностях и напряжения на емкостях указанные в свойствах элементов. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Подготовка к работе. Лабораторное задание

Существует возможность наблюдать результаты частотного анализа и 
анализа переходного процесса не только как функции частоты или времени, 
но и, заменяя переменную по оси X на любую другую схемную функцию, 
получать требуемые функциональные зависимости. 

 
Подготовка к работе 

 
Ознакомиться с целями и содержанием лабораторной работы. 
Изучить теоретические сведения к работе. Дополнительная литература 

для подготовки см. [4, 8, 17]. 
Пройти входное тестирование или опрос для допуска к лабораторной 

работе. 
Получить у преподавателя номер варианта и выбрать соответствую-

щую схему по Приложению 1. 
Изобразить упрощенную схему для статического анализа (по постоян-

ному току), предполагая, что все элементы схемы идеальные. При этом ис-
точники ЭДС и тока – постоянные, а их номиналы: 

 

 

 

 

1

2

Варианта В ;

Варианта
В ;

2
Варианта мА .

E №

№
E

Y №







 

 

Пользуясь упрощенной схемой рассчитать узловые напряжения и токи 
в ветвях схемы, включая токи индуктивности и источников ЭДС. Рассчитать 
малосигнальную передаточную функцию в режиме по постоянному току, 
входное и выходное сопротивления, входы и выходы выбрать по табл. 3. 

 
Лабораторное задание 

 
1. Ввести схему в ЭВМ. 
2. Анализ статического режима. 
● произвести с помощью ЭВМ расчет узловых напряжений, токов в 

элементах и мощностей для режима по постоянному току; 
● рассчитать малосигнальную передаточную функцию в режиме по по-

стоянному току, входное и выходное сопротивления, входы и выходы по табл. 3. 
3. Частотный анализ. Получить с помощью ЭВМ: 
● зависимости модуля комплексного коэффициента передачи от час-

тоты (АЧХ); 
● зависимости фазового угла комплексного коэффициента передачи 

от частоты (ФЧХ), для четного варианта – фаза напряжения, для нечетного –
 фаза тока; 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Ввод и подготовка схемы

● зависимости группового времени запаздывания; 
● амплитудно-фазовые частотные характеристики (годографы). 
Источник входного воздействия, тип отклика и выходы определить 

по табл. 3 в соответствии с вариантом. 
 

Таблица 3 
 

Вид анализа Анализ статического режима Частотный Анализ 
Динамический анализ 

Вариант Четный Нечетный Четный Нечетный 
Источник входного 
воздействия 

Источник 
напряжения Е1 

Источник 
тока Y 

Источник 
напряжения Е1 

Источник 
тока Y 

Тип отклика и 
выходы 

Напряжение 
на источнике 

тока Y 

Ток источника
напряжения Е1

Напряжения 
в узлах схемы 

Токи 
реактивных 
элементов 

 
4. Динамический анализ. Получить с помощью ЭВМ временные ха-

рактеристики цепи: 
● переходные; 
● импульсные (путем взятия производной по времени от переходной 

характеристики, средствами PSpice). 
В качестве входного воздействия, для четного варианта использовать 

передний фронт единичного импульса напряжения, для нечетного – передний 
фронт единичного импульса тока. Отклики в соответствии с табл. 3. 

 
Порядок выполнения работы и рекомендации 

 
Ввод и подготовка схемы 

 
1. Загрузить графический редактор схем – программный модуль Or-

CAD Capture (CIS). 
2. Создать проект (Analog or Mixed A/D) и средствами Capture ввести 

схему, соответствующую своему варианту, в ЭВМ. 
Источники напряжения и тока должны быть постоянными (VDC и 

IDC), с номиналами равными полученным при подготовке к работе. 
3. Обозначить узлы схемы. Для этого необходимо присвоить псевдо-

нимы цепей (Net Alias), которые определяются по команде Place>Net 
Alias…, инициируемой также нажатием клавиши N или щелчком соответст-
вующего значка на панели инструментов (рис. 1). В открывшемся диалого-
вом окне в поле Name ввести обозначение узла схемы и щелкнуть ОК, после 
чего за курсором мыши закрепляется прямоугольник одну из сторон которо-
го необходимо совместить с участком цепи (справа или сверху от проводни-
ка) и щелкнуть левой кнопкой мыши, закрепив, таким образом, псевдоним за 
цепью. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Анализ статического режима. Напряжения, токи и потребляемые мощности

Псевдонимов у цепи может быть несколько, в редакторе свойств 
(Property Editor) можно в строке Name выбирать в выпадающем списке лю-
бое имя из используемых псевдонимов цепи, однако задать имя можно толь-
ко по команде Place>Net Alias. 

 

 
Рис. 1. Присвоение псевдонимов цепей 

 

Для обозначения цепей схемы в OrCAD Capture применяется система 
сложных меток типа N00032, не удобная для пользователя. Узлу, выбранно-
му в качестве опорного (общего) присваивается псевдоним 0. 

В принципе, в OrCAD, не обязательно соединять цепи с помощью про-
водов, достаточно присваивать цепям одинаковые псевдонимы. 

 
Анализ статического режима. Напряжения узлов схемы, 

токи и потребляемые мощности элементов 
 

4. Создать профиль моделирования. Команда PSpice>New Simulation 
Profile (Alt+S+N) или щелчок соответствующего значка на панели инстру-
ментов (рис. 2). В открывшемся диалоговом окне в поле Name ввести имя 
нового профиля и щелкнуть Create. После этого автоматически откроется 
диалоговое окно настройки профиля моделирования Simulation Settings на 
закладке Analysis – выбор типа, и настройка анализа. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Анализ статического режима. Напряжения, токи и потребляемые мощности

 
Рис. 2. Создание нового профиля моделирования 

 

Файлы профилей моделирования – это тестовые файлы с расширени-
ем *.sim, по умолчанию располагаются в директории проекта – \<имя про-
екта>-PSpiceFiles\<имя схемы>\. 

При создании нового проекта обычно профиль создается автоматиче-
ски и носит имя проекта. Тип анализа в профиле, созданном одновременно с 
проектом – Bias Point – анализ по постоянному ток. Во вновь создаваемом 
профиле, по умолчанию выбран тип анализа – Time Domain – анализ схемы 
во временной области. За одним проектом может быть закреплено несколь-
ко профилей, которые можно менять в соответствующем выпадающем 
меню (рис. 3), или в дереве проекта. 

 

 
Рис. 3. Выпадающее меню выбора профиля моделирования 

 

Диалоговое окно настройки профиля моделирования (Simulation Set-
tings) можно вызвать командой PSpice>Edit Simulation Profile, сочетанием 
клавиш клавиатуры Alt+S+E или щелкнув по соответствующему значку на 
панели инструментов (рис. 4). Для моделирования, удобно в одном проекте 
иметь несколько профилей настроенных на разные типы анализа. 

Сочетания клавиш, начинающиеся с Alt, представляют собой спо-
соб доступа к командам меню с клавиатуры, символьные сочетания, сле-
дующие за Alt – это, как правило, первые буквы соответствующих ко-
манд меню, за пунктом меню PSpice закреплен символ S. Далее, в связи с 
простотой формирования комбинаций, подобные сочетания клавиш при-
водиться не будут. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Анализ статического режима. Напряжения, токи и потребляемые мощности

Окно настройки профиля моделирования можно вызвать двойным 
щелчком по выбранному профилю в дереве проекта (папка PSpice Re-
sources>Simulation Profiles). 

 

 
Рис. 4. Вызов окна настройки моделирования 

 

5. Выбрать тип анализа Bias Point (рис. 5). 
 

 
Рис. 5. Окно настройки моделирования. Выбор типа анализа 

 

6. Запустить симуляцию. Команда PSpice>Run, F11 на клавиатуре, или 
щелчок соответствующего значка на панели инструментов (рис. 6). 

 

 
Рис. 6. Запуск моделирования 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Анализ статического режима. Напряжения, токи и потребляемые мощности

Моделирование выполняется в модуле PSpice A/D. После запуска симуля-
ции, если в схеме не было допущено формальных ошибок, типа двойных позици-
онных обозначений компонентов, компонентов с не подсоединенными вывода-
ми и т.п., будет создан файл с расширением *.net (файл соединений) и откро-
ется окно программы PSpice A/D. 

Файл соединений (Netlist file) – это текстовый файл, содержащий пози-
ционные обозначения компонентов, псевдонимы узлов к которым подключены 
компоненты, а также параметры компонентов или их имена для поиска в биб-
лиотеке моделей. Файл соединений располагается в директории проекта –
 \<имя проекта>-PSpiceFiles\<имя схемы>\. 

 

 
Рис. 7. Окно программы PSpice A/D. Симуляция завершена 

 

В окне PSpice A/D, основная на данном этапе, информация содержит-
ся в подокне Output Window (окно выхода) (рис. 7). 

Удостовериться в том, что симуляция была завершена, и свернуть окно 
программы PSpice A/D. 

7. Открыть файл соединений (Netlist file). В OrCAD Capture команда 
PSpice>View Netlist. При этом важно, чтобы в файловых ассоциациях опе-
рационной системы, расширению *.net был сопоставлен какой-нибудь тек-
стовый редактор. Сохранить содержимое файла Netlist в заготовку отчета. 

8. Включить в OrCAD Capture отображение на схеме результатов ана-
лиза по постоянному току – показ рассчитанных значений потенциалов в уз-
лах, токов и потребляемой компонентами мощности. Управление отображе-
нием осуществляется через главное меню – PSpice>Bias Point>… и с помо-
щью пиктограмм панели инструментов (рис. 8). 

Ненужные индикации потенциалов, токов и мощностей можно удалить, 
отметив эти данные с помощью мыши и затем нажав клавишу Delete. Удален-
ные данные всегда можно вернуть на экран, отметив нужный сегмент провод-
ника или компонент и затем щелкнув по кнопке с пиктограммой ,  или . 
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Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Анализ статического режима. Напряжения, токи и потребляемые мощности

 
Рис. 8. Управление отображением режима по постоянному току 

 

Передвинуть с помощью мыши отобразившиеся значения токов и на-
пряжений так, что бы схема имела читаемый вид (рис. 9). 

9. Зафиксировать полученный результат с помощью скриншота 
(Screenshot), и сохранить в заготовке отчета. 

 

 
Рис. 9. Отображение токов через элементы и напряжений в узлах 

 

Если нажать сочетание Alt+PrScr, то в буфер сохранится только ак-
тивное окно. 

 
Основы компьютерного проектирования и моделирования РЭС 

Лабораторный практикум 19



 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Анализ статического режима. Передаточная функция, входное и выходное сопротивления

Анализ статического режима. Малосигнальная передаточная функция, 
входное и выходное сопротивления 

 
10. Открыть окно настройки профиля моделирования (Simulation 

Settings) 1 и в разделе Output File Options установить флажок Calculate 
small-signal DC gain (.TF). В поле From input source name ввести имя вход-
ного источника (имя первого источника напряжения или источника тока, для 
четного и нечетного варианта соответственно). В поле To Output variable 
ввести обозначение выходного параметра (напряжение на источнике тока 
или ток первого источника напряжения, для четного и нечетного варианта 
соответственно). Пример показан на рис. 10. 

11. Запустить симуляцию.2 
12. Открыть схемный файл (Circuit file). В программе PSpice A/D 

выполнить команду File>Open, найти в директории проекта по адресу 
\<имя проекта>-PSpiceFiles\ <имя схемы>\ <имя профиля>\ и открыть 
файл имеющий расширение *.cir. Имя файла совпадает с именем профиля 
моделирования. 

 

 
Рис. 10. Окно настройки моделирования. Настройка параметров анализа для расчета 

малосигнальной передаточной функции в режиме по постоянному току 
 

Схемный файл создается в OrCAD Capture после запуска симуляции, 
при условии, что в схеме не было допущено формальных ошибок, и содержит 
команды, описывающие как нужно выполнять моделирование (директивы 
моделирования) сформированные на основе файла *.sim (файла профиля мо-
делирования). Схемный файл также содержит ссылки на файл списка со-
единений (Netlist file) и другие файлы которые могут содержать модели, 
сигналы и любую другую определяемую пользователем информацию, исполь-
зуемую в моделировании. 

Перед непосредственным выполнением процесса моделирования про-
грамма PSpice A/D прочитывает все связанные с проектом файлы, указан-
ные в файле *.cir. На этом этапе могут быть выявлены формальные ошибки 
в задании директив моделирования, в описаниях моделей и т. п. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Анализ статического режима. Передаточная функция, входное и выходное сопротивления

13. Сохранить текст из схемного файла в заготовке отчета, предвари-
тельно удалив из него пустые строки. Пример текста схемного файла пока-
зан на рис. 11. 

В строке 1 – имя и расположение файла с настройками моделирования. 
В строках с 7 по 10 указаны библиотеки, используемые в данном проекте. 

Директива .LIB (library) подключает библиотеку моделей. Библиотека nom.lib 
содержит директивы подключения всех используемых стандартных библиотек. 

В строках с 13 по 15 содержатся директивы анализа. 
Директива .TF задает расчет малосигнальной передаточной функции 

(Transfer Function) в режиме анализа по постоянному току, входного и вы-
ходного сопротивления. 

Директива .PROBE подключает графический постпроцессор Probe, в 
котором строятся и анализируются графики (в анализе Bias Point, Probe не 
используется). 

Директива .INC (include) включает во входной файл любой другой 
файл, в данном случае файл Netlist – SCHEMATIC1.net – собственно анализи-
руемая схема. 

 
 

1 ** Profile: "SCHEMATIC1-post" [ C:\OrCAD_Data\test-pspicefiles 
**  \schematic1\post.sim] 
 
2 ** Creating circuit file "post.cir" 
3 ** WARNING: THIS AUTOMATICALLY GENERATED FILE MAY BE OVERWRITTEN BY 
SUBSEQUENT SIMULATIONS 
 
4 *Libraries: 
5 * Profile Libraries : 
6 * Local Libraries : 
7 * From [PSPICE NETLIST] section of C:\OrCAD\OrCAD_16.0\tools\ 
**  PSpice\PSpice.ini file: 
8 .lib "nom.lib" 
 
9 *Analysis directives: 
10 .TF V(I_I1) V_V1 
11 .PROBE V(alias(*)) I(alias(*)) W(alias(*)) D(alias(*)) 
NOISE(alias(*)) 
12 .INC "..\SCHEMATIC1.net" 
13 
14 .END 
 

Рис. 11. Схемный файл (Circuit file) 
 

Директива .END – конец схемного файла. 
Проведение анализа Bias Point не требует специальной директивы и по 

умолчанию проводится всегда. 
Строки, начинающиеся с символа «*» – это комментарии используе-

мые, в том числе как заголовки разделов. Строки, начинающиеся с «.» со-
держат директивы моделирования. 
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Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Анализ статического режима. Передаточная функция, входное и выходное сопротивления

Программа PSpice A/D является автономным модулем выполняющим 
моделирование проектов. Входными данными для PSpice A/D являются файл 
*.cir и указанные в нем связанные файлы, в том числе файлы *.net –
 представляющий собой описание схемы и *.sim – содержащий ряд директив, 
в том числе директивы анализа. 

Все связанные файлы проекта, используемые в моделировании – это 
текстовые файлы которые могут быть включены в схемный файл не толь-
ко как ссылки, но и в явном виде (как текст). Пользователь может вно-
сить изменения в схему, формировать собственные задания на моделиро-
вание, подключать библиотеки и т.п. пользуясь любым текстовым редак-
тором. Например, директивы моделирования можно включать в файл со-
единений *.net. 

Следует иметь в виду, что файл соединений *.net перезаписывается 
каждый раз, когда запускается симуляция из OrCAD Capture. Файл настроек 
моделирования *.sim и схемный файл *.cir обновляются запуском симуляции 
как OrCAD Capture, так и из PSpise A/D. 

14. Открыть выходной файл (Output file). В программе PSpice A/D вы-
полнить команду View>Output File или щелкнуть соответствующий значок 
панели инструментов (рис. 12). 

 

 
Рис. 12. Просмотр выходного файла 

 

Открыть выходной файл можно также способом, аналогичным опи-
санному в п. 12. Выходной файл имеет расширение *.out и имя, совпадающее 
с именем профиля моделирования. 

Часть результатов моделирования, а также сообщения об ошибках 
моделирования доступны только в текстовом виде в выходном файле, в ча-
стности результаты расчетов по директиве .TF. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Частотный анализ. АЧХ

15. Сохранить текст из выходного файла в заготовке отчета, предвари-
тельно удалив из него пустые строки. Выделить в тексте результаты расчета 
малосигнальной передаточной функции в режиме анализа по постоянному 
току, входного и выходного сопротивлений (рис. 13). 

 

**** SMALL-SIGNAL CHARACTERISTICS 
 

 V(I_I1)/V_V1 = -2.500E-01 
 

 INPUT RESISTANCE AT V_V1 = 4.000E+01 
 

 OUTPUT RESISTANCE AT V(I_I1) = 2.750E+01 
 

 JOB CONCLUDED 
  

**** 12/02/10 00:34:15 ******* PSpice 16.0.0 (July 2006) ****** ID# 0 *
 

 ** Profile: "SCHEMATIC1-post" [ C:\OrCAD_Data\test- 
* pspicefiles\schematic1\post.sim ] 
 

 **** JOB STATISTICS SUMMARY 
 

 Total job time (using Solver 1) = .02  

Рис. 13. Фрагмент выходного файла (Output file) 

результаты расчета малосиг-
нальной передаточной функ-
ции в режиме анализа по
постоянному току, входного и 
выходного сопротивлений 

 

Более подробно текстовый интерфейс программы PSpise A/D, работа 
с файлами *.cir и *.out, директивы моделирования описаны в [11, 17, 18]. 

 
Частотный анализ. АЧХ 

 
16. Преобразовать схему в соответствии с п. 3 лабораторного задания. 

Вместо источника входного воздействия поставить источник VAC или IAC 
(в соответствии с вариантом), амплитуду переменной составляющей задать 
произвольно, но не равной нулю. Остальные источники исключить из схемы. 
Источник тока имеет бесконечное внутреннее сопротивление (разрыв це-
пи), а источник напряжения нулевое (перемычка). 

Поскольку цепь линейная, а снять требуется АЧХ и ФЧХ амплитуда 
входного воздействия роли не играет (в пределах величин допустимых в 
PSpice, для напряжений и токов – 1010  вольт или ампер). 

VAC и IAC – источники гармонического сигнала для частотного ана-
лиза, могут использоваться для анализа по постоянному току. 

17. Создать новый профиль моделирования.3 
18. Выбрать тип анализа AC Sweep – анализ схемы в частотной облас-

ти. Первоначальные параметры анализа задать, как показано на рис. 14. 
Выбор шага по частоте: Linear – линейный, Logarithmic –

 логарифмический. Для линейного шага указывается общее число точек на 
шкалу (Total Points), для логарифмического число точек на декаду или окта-
ву (Points/Decade(Octave)). Start Frequency – начальная частота анализа, не 
может быть равна 0. End Frequency – конечная частота анализа. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Настройка внешнего вида области построения и графиков 

 
Рис. 14. Окно настройки моделирования. Настройка анализа AC Sweep 

 

19. Запустить симуляцию. 
20. Открыть выходной файл (Output File) 4  найти и скопировать в заго-

товку отчета раздел с директивами анализа (Analysis directives). 
Анализ в частотной области задается по директиве .AC. 

 21. Построить графики АЧХ. 
АЧХ представляет собой зависимость модуля комплексного коэффи-

циента передачи от частоты, может быть определена как отношение ам-
плитуд входного и выходного сигнала. 
 21.а. Открыть окно Add Traces. В PSpice A/D команда Trace>Add 
Trace…, клавиша Insert или кнопка на панели инструментов (рис. 15). 

В версии OrCAD 16 добавить график можно также через контекст-
ное меню, вызываемое щелчком правой кнопки мыши на пустующую область 
построения. 

 

 
Рис. 15. Вызов окна Add Traces 

 

Непосредственно функции построения графиков и постобработки ре-
зультатов моделирования выполняются графическим постпроцессором 
Probe встроенным в PSpice A/D. 
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 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Настройка внешнего вида области построения и графиков 

 21.б. В окне Add Traces (добавить график) с помощью клавиатуры или 
мыши ввести в строку Trace Expression выражения для АЧХ всех выходов 
(рис. 16), как отношения выходных, входных напряжений (четный вариант) 
или токов (нечетный вариант). 

В левой части окна Add Traces перечислены все токи и потенциалы узлов 
вашей схемы. В правой части – список математических функций и связующих, 
которые программа Probe может применить к отдельным графикам. 

 

 
Рис. 16. Ввод выражений графиков в окне Add Traces 

 

В результате анализа AC Sweep рассчитываются узловые напряжения 
и токи ветвей, являющиеся комплексными величинами. В режиме AC Sweep 
программа Probe поддерживает вычисления с комплексными числами. Ввод в 
строку Trace Expression окна Add Traces выражений для комплексных вели-
чин без использования каких-либо математических функций и операторов 
Probe, выводит модуль результата. Если введено выражение для действи-
тельной величины, например фаза комплексного коэффициента передачи, то 
результат может быть и отрицательным. Если же выражение комплекс-
ное, например комплексный коэффициент передачи по напряжению 
V(N1)/V(N4) – определенный как отношение потенциалов узлов N1 и N4, то 
выводится его модуль, который всегда неотрицательный. 

Для обращения к действительной и мнимой части рассчитанных вели-
чин используются функции R и IMG соответственно. 

В программе Probe также используется функция ABS (absolute value) –
 абсолютное значение и аналогичная ей M (magnitude) – модуль, соответст-
венно выражения: V(N1)/V(N4), M(V(N1)/V(N4)), ABS(V(N1)/V(N4)) и 
SQRT(PWR(R(V(N1)/V(N4)),2)+PWR(IMG(V(N1)/V(N4)),2)) – совершенно экви-
валентны. Функция SQRT – квадратный корень, а PWR – возведение в сте-
пень, в приведенном примере в квадрат. 
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Настройка внешнего вида области построения и графиков 

 21.в. Проанализировать вид полученных АЧХ, открыть окно настройки 
профиля моделирования (Simulation Settings) и изменить, если требуется, 
граничные частоты анализа, тип шага по частоте, число точек таким образом, 
чтобы графики приобрели наиболее информативный вид. 

Вызвать окно Simulation Settings и изменить директивы моделирова-
ния можно прямо из программы PSpice A/D, щелкнув соответствующий зна-
чок панели инструментов (рис. 17) или командой Simulation>Edit Profile…. 
 21.г. В окне Simulation Settings, на закладке Probe Windows поставить 
флажок Last plot в группе Show (рис. 18) – вывод графиков для последних 
введенных выражений. 
 21.д. Если директива моделирования была изменена, запустить симу-
ляцию еще раз. 

Запустить симуляцию можно прямо из программы PSpice A/D, нажав 
соответствующую кнопку на панели инструментов (рис. 17) или командой 
Simulation>Run. 

 

 
Рис. 17. Вызов окна Simulation Settings (команда Edit Profile) 
и запуск симуляции (команда Run) из программы PSpice A/D 

 

 
Рис. 18. Окно Simulation Settings. 

Закладка Probe Window – настройка отображения результатов моделирования 
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После каждой симуляции обнуляется информация о выражениях, вве-
денных в строку Trace Expression, опция Show Last plot позволяет не вво-
дить выражения заново. 

 
Настройка внешнего вида области построения и графиков 

 
 21.е. При необходимости изменить масштаб отображения по осям (ли-
нейный или логарифмический) (рис. 19). 

 

 
Рис. 19. Изменения масштаба отображения по осям. 

Вызов окна Axis Settings 
 

 21.ж. Убрать промежуточные линии сетки. 
Открыть окно настройки параметров сетки и осей (Axis Settings). Коман-

да Plot>Axis Settings…, либо двойной щелчок левой кнопки мыши в области 
значений одной из осей, либо выбрать пункт контекстного меню доступного по 
щелчку правой кнопки мыши по линии сетки (пункт Settings…) (рис. 19). 

В окне Axis Settings на закладках X Grid и Y Grid в разделе Minor 
Grids установите флажок None (рис. 20). 
 21.з. Настроить отображение графиков. 

Вызвать окно свойств графика (Trace Properties). Щелкнуть правой кноп-
кой мыши линию графика или значок в строке с легендами графиков, под осью Х 
(рис. 21). В появившемся контекстном меню выбрать пункт Properties…. 

В окне Trace Properties изменить параметры отображения графика: 
увеличить толщину линий графиков, изменить цвет и тип линий. 

Повторить действия для всех графиков. 
Аналогичным образом настраиваются параметры отображения ли-

ний рамки и сетки. 
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Толщина линий влияет на качество печати и восприятия. Следует вы-
бирать цвета линий, которые при черно-белой печати обеспечивают прием-
лемую четкость и контраст на белом фоне. 

 

 
Рис. 20. Окно Axis Settings. Настройка отображения промежуточных линий сетки 

 

 
Рис. 21. Настройка вида графиков 

 

 21.и. Сохранить графики АЧХ. Команда Window>Copy to Clipboard 
(сохранить в буфер обмена), в открывшемся окне в разделе Foreground по-
ставить флажок change white to black (поменять белый с черным), щелкнуть 
OK (рис. 22). Рисунок из буфера обмена вставить в заготовку отчета (Ctrl+V 
или Shift+Ins). 

В буфер копируется область построения, включая оси, сетку, графики, 
подписи к осям, легенда и текстовые пометки (рис. 23). Размер изображе-
ния в буфере, зависит от фактического размера области построения в мо-
мент копирования. 
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Рис. 22. Сохранение графиков в буфер обмена 

 

 
Рис. 23. Графики, скопированные из буфера обмена 

 

Рисунок в буфере обмена имеет векторный формат, его можно вста-
вить и отредактировать в любом векторном редакторе – MS Visio, Illustra-
tor, Corel Draw, Inkscape и т. п. 

 
Частотный анализ. ФЧХ 

 
 22. Построить графики ФЧХ. 

 22.а. Последовательно отредактировать выражения для графиков. Два-
жды щелкнуть в строке легенды выбранное выражение и в строке Trace Ex-
pression открывшегося окна Modify Trace изменить формулу, как показано в 
примере (рис. 24). 
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Рис. 24. Редактирование выражений графиков 

 

В окне Modify Trace в отличие от аналогичного окна Add Traces раз-
решено только редактирование ранее введенного выражения. В окне Add 
Traces можно вводить несколько выражений. 

Для нечетного варианта выражения фазы частотного отклика могут 
выглядеть как: P(I(C1)), P(I(C2)), P(I(L1)). 

ФЧХ представляет собой зависимость разности фаз двух гармониче-
ских колебаний от частоты, в данном случае фазовый сдвиг между выход-
ным и входным сигналом. ФЧХ может быть определена как аргумент ком-
плексного коэффициента передачи, ФЧХ также определяют как арктангенс 
отношения мнимой и действительной части комплексного коэффициента 
передачи. Следует помнить, что аргумент комплексной функции принимает 
значения от −π до π, а арктангенс от −π/2 до π/2, в отличие от абсолютно-
го фазового сдвига, который может принимать значения больше π. 

Фаза частотного отклика в программе Probe находиться с помощью 
функции P(имя переменной), Р – от английского phase – фаза. Функция Р воз-
вращает абсолютное значение фазы (сдвиг относительно 0) в градусах (de-
gree). Поскольку фаза входного сигнала не была изменена и по умолчанию 
равна 0, то для нахождения ФЧХ можно построить фазы выходных вели-
чин, а не коэффициентов передачи. 
 22.б. Сохранить в заготовке отчета графики ФЧХ.5 

 
Частотный анализ. Групповое время запаздывания 

 
Характеристика ГВЗ показывает время прохождения сигналов разных 

частот через схему, характеризует время задержки максимума передаваемой 
энергии и находится как производная от фазо-частотной характеристики. 

 
 

Основы компьютерного проектирования и моделирования РЭС 
Лабораторный практикум 30



 Лабораторная работа №1. Статический, частотный и временной анализ пассивной RLC цепи
Частотный анализ. АФЧХ

 
 

Основы компьютерного проектирования и моделирования РЭС 
Лабораторный практикум 31

Групповое время запаздывания в программе Probe находиться с помо-
щью функции G(имя переменной), G – от английского group delay. Функция G 
вычисляет производную от ФЧХ в радианах по угловой частоте по формуле 

, и имеет размерность времени. 

 23. Построить графики ГВЗ. 
 23.а. Последовательно отредактировать выражения для графиков. 
Дважды щелкнуть в строке легенды выбранное выражение и в строке 
Trace Expression открывшегося окна Modify Trace изменить формулу, 
заменив P на G (рис. 25). 
 

 d d  

 
Рис. 25. Ввод выражений для группового времени запаздывания 

в строку Trace Expression окна Add Traces 
 

 23.б. Сохранить в заготовке отчета графики ГВЗ. 
 

Частотный анализ. АФЧХ 
 

Амплитудно-фазовая частотная характеристика – зависимость ко-
эффициента передачи и фазового сдвига от частоты, построенная в поляр-
ной системе координат – представляет собой годограф комплексного ко-
эффициента передачи, называемый также диаграммой или годографом 
Найквиста. Годограф – это параметрическая кривая параметром, которой 
является частота, строится в виде кривой описываемой концом вектора 
комплексного коэффициента передачи (для АФЧХ) при изменении частоты 
от 0 до ∞, причем каждой точке кривой соответствует определенная час-
тота. 

При построении АФЧХ на комплексной плоскости, по оси X обычно 
откладывается вещественная, а по оси Y мнимая часть комплексного коэф-
фициента передачи. 

В PSpice A/D, после анализа AC Sweep, постпроцессором Probe по 
умолчанию строятся графики, где по оси X отложена частота, а по оси Y 
переменная, определяемая через окно Add Traces или маркерами на схеме. 

Для построения АФЧХ требуется переопределить переменную по оси 
X, и задать переменную оси Y. 

24. В PSpice A/D открыть новое окно. Команда Window>New Window 
(рис. 26). На панели окон PSpice появиться новая закладка, переключаться 
между окнами можно щелкая мышью на соответствующие закладки или с 
помощью меню Window. 

С помощью новых окон можно выводить и анализировать большое 
число различных графиков и данных, не удаляя, и не переопределяя уже суще-

5
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ствующие, т.е. работать с большим объемом информации, для которого 
одного окна недостаточно. 

 

 
Рис. 26. Добавление нового окна в PSpice A/D 

 

25. Добавить в текущем окне еще несколько (по числу выходов) облас-
тей построения. Команда Plot>Add Plot To Window или соответствующий 
пункт контекстного меню вызываемого щелчком правой кнопки мыши по 
области построения (рис. 27). 

В одном окне PSpice A/D может быть несколько систем координат 
содержащие построения, привязанные к одной оси X или имеющие независи-
мые (собственные) оси. 

26. Назначить каждой области построения собственную ось X. Выбрать 
любую область построения, щелкнув в пространство области, затем выпол-
нить команду Plot>Unsynchronize X Axis (рис. 27). 

Чтобы убедиться в выборе нужной области построения, обратите на 
значок выбора – SEL>> (рис. 27). 

 

 
Рис. 27. Добавление области построения. 

Назначение области построения собственной оси X 
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 27. Построить АФЧХ. 
 27.а. Изменить переменную, откладываемую по оси X. 

 27.а.1. Открыть окно настройки параметров сетки и осей (Axis Set-
tings)6 для одной из областей построения. В окне Axis Settings на закладке X 
Axis нажать на кнопку Axis Variable… (рис. 28). 

 27.а.2. В открывшемся окне X Axis Variable в строке Trace Expres-
sion изменить переменную Frequency на вещественную часть одного из ком-
плексных коэффициентов передачи (для напряжений или токов, в соответст-
вии с вариантом), пример показан на рис. 29. 
 

 
Рис. 28. Вызов окна X Axis Variable. Изменение переменной откладываемой по оси X 

 

Вещественная часть комплексной переменной в программе Probe на-
ходиться с помощью функции R(имя переменной), – от английского real –
 действительный, реальный. Функция R возвращает значение действитель-
ной части комплексной переменной в соответствующих единицах измерения 
(вольты, амперы и т. п.). 

 

 
Рис. 29. Окно X Axis Variable. Изменение переменной откладываемой по оси X 
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Окно X Axis Variable аналогично Add Traces, но, как и Modify Trace, 
поддерживает ввод или изменение только одного выражения, т.е. каждая 
область построения может иметь только одну ось X. 

 27.а.3. Повторить пп. 27.а.1 и 27.а.2 для каждой области построения, 
изменяя переменные осей X на действительные части комплексных коэффи-
циентов передачи. 

В итоге должно получиться окно PSpice A/D, в котором имеется не-
сколько областей построения, в каждой из которых по оси X отложена дей-
ствительная часть комплексного коэффициента передачи (рис. 30). 

 

 
Рис. 30. Области построения в PSpice A/D с независимыми осями Х 

 

 27.б. Добавить переменную для оси Y. 
 27.б.1. Выбрать любую область построения, щелкнув в пространство 

области, затем открыть окно Add Traces.7 
 27.б.2. В окне Add Traces в строку Trace Expression ввести выраже-

ние для мнимой части соответствующего комплексного коэффициента пере-
дачи (для напряжений или токов, в соответствии с вариантом) (рис. 31). 

Мнимая часть комплексной переменной в программе Probe находиться 
с помощью функции IMG(имя переменной), – от английского imaginary –
 мнимый. 

 27.б.3. Повторить пп. 27.б.1 и 27.б.2 для каждой области построения. 
 

 
Рис. 31. Ввод выражений для мнимой части комплексного коэффициента передачи 

в строку Trace Expression окна Add Traces 
 

В итоге должно получиться окно PSpice A/D, в котором построены 
АФЧХ, каждый график в отдельной области построения (рис. 32). 
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Рис. 32. Графики АФЧХ 

 

 
Рис. 33. Графики АФЧХ совмещенные в одну координатную сетку 

с помощью редактора Inkscape 
 

К сожалению, в PSpice A/D нет возможности построить годограф 
для различных выходов в одной области построения, поскольку в каждой об-
ласти построения возможна только одна ось X. Однако скопированный ри-
сунок из буфера обмена можно вставить в векторный редактор разгруппи-
ровать и легко совместить, как показано на рис. 33. 
 27.в. Сохранить в заготовке отчета графики АФЧХ. 5
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Динамический анализ. Переходные характеристики 
 
8. Преобразовать схему в соответствии с п. 4 лабораторного задания. 

Вмест

Таблица 4 
 

Значения параметров источника PULSE 

Параметр Значени
 

е Примечание 
V1 (I1) 0 Амплитуда подошвы импульса 
V2 (I2) 1 Амплитуда вершины импульса 
TD 0 Задержка (Time Delay) 
TR 1n Время нарастания переднего фронта (Time Rise) 
TF 1n Время спада заднего фронта (Time Fall) 
PW 2 Длительность вершины импульса (Pulse Width) 
PER 3 Период повторения (Period) 

2
о источника входного воздействия поставить источник VPULSE или 

IPULSE (в соответствии с вариантом), параметры источника задать, как по-
казано в табл. 4. 

 

 
 

PULSE, IPULSE – импульсные источники, позволяют задавать воз-
дейст

люче-
ния (с

ь функцию включения, можно подавая на вход прямо-
угольн

ыть 
меньш

новый профиль моделирования. 
ализ схемы во временной 

облас

котор

V
вие в виде периодической последовательности импульсов трапецеи-

дальной, пилообразной, треугольной и прямоугольной формы, применяются в 
динамическом анализе, при задании соответствующих параметров могут 
использоваться в частотном анализе и анализе по постоянному току. 

Переходная характеристика – это отклик цепи на функцию вк
тупенчатое воздействие). Следует знать, что PSpice оперирует ко-

нечными значениями переменных, и нет возможности задать идеальную 
функцию включения, у которой амплитуда нарастает мгновенно, с беско-
нечной скоростью. 

Смоделироват
ый импульс единичной амплитуды, с длительностью переднего фрон-

та много меньшей длительности переходных процессов в схеме, а длитель-
ностью импульса больше длительности переходных процессов, т. е. задний 
фронт нужно отодвинуть в область времен установившегося режима. 

Период повторения импульсов для источников PULSE не может б
е суммы TR+PW+TF. Если длительности TR и TF задать равными ну-

лю, то PSpice автоматически присвоит им значения равные 1% от общего 
времени анализа. 

29. Создать 
30. Выбрать тип анализа Time Domain – ан
ти. Первоначальные параметры анализа задать, как показано на рис. 34. 
Run to time – общее время анализа, Start saving data after – время после 
ого начинается фиксация данных, Maximum step size – максимальный 

шаг интегрирования. 

3
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Целесообразно ограничить максимальный шаг величиной приблизи-
тельно в 1000 раз меньшей общего времени анализа. По умолчанию величина 
этого параметра составляет 2% от времени анализа, т. е. на весь график 
будет рассчитываться не менее 50 точек, этого часто недостаточно для 
отображения графически точных и красивых результатов. 

 

 
in

а закладке Probe Window окна Simulation Settings 

Рис. 34. Окно настройки моделирования. Настройка Time Doma  
 

1. Н поставить 
флажо

офиль моделирования новый, то и настройки Probe надо 
устан

ься одним профилем моделирования, но целесообраз-
но со

л (Output File)  найти и скопировать в заго-
товку

 
в строку Trace Expression выражения 

3
к Last plot. 
Поскольку пр
авливать заново. 
Можно пользоват
здать несколько профилей для различных видов анализа, при этом для 

облегчения ориентирования желательно задавать значащие имена профи-
лей, например: AC_Sweep, Time_1 и т. п. 

32. Запустить симуляцию. 
33. Открыть выходной фай
 отчета раздел с директивами анализа (Analysis directives). 

 34. Построить графики переходных характеристик. 
34.а. Открыть окно Add Traces. 

 34.б. В окне Add Traces ввести 
для входного сигнала и откликов на всех выходах (рис. 35), ток для нечет-
ных, а напряжение для четных вариантов. 

 

 
Рис. 35. Ввод выражений графиков переходных характеристик 

в строку Trace Expression окна Add Traces 
 

 34.в. Проанализировать вид полученных переходных характеристик, при 
необходимости, открыть настройки профиля моделирования (Simulation Set-
tings)8 и изменить общее время анализа и максимальное значение шага. Если 
настройки моделирования были изменены, запустить симуляцию еще раз.9 
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Время анализа задать таким образом, что бы графики переходных ха-
ракте

ь за величиной 
макси

 графиков, при необходимости цвет, тип линии. 

ристик были видны полностью, вплоть до установившегося значения. 
В примере (рис. 36) время моделирование составило 200 мкС. 

При изменении времени моделирования следует следит
мального шага. Для схемы из 5 узлов и 9 ветвей, при разнице между 

временем моделирования и шагом в 106 раз, файл результатов анализа мо-
жет превысить 100 Мбайт. 
 34.г. Увеличить толщину
 34.д. Сохранить графики переходных характеристик в заготовке отчета. 
 

 
Рис. 36. Входной сигнал и переходные характеристики для токов 

Если временные отклики имеют времена переходных процессов, отли-
чающиеся на несколько порядков, построить и сохранить графики отдельно, 
с различными временами моделирования. 

 
Динамический анализ. Импульсные характеристики 

 
Импульсная характеристика – это отклик цепи на дельта-функцию –

 импульс бесконечно малой длительности и бесконечно большой амплитуды, 
с площадью равной единице. 

Зная, что импульсная и переходная характеристики связаны соотно-
шением – g t   ht  , где g t   – импульсная, а h t   – переходная характе-

ристика, можно с помощью средств постпроцессора Probe взять производ-
ную от полученных переходных характеристик. 

В переходной характеристике в начальный момент времени 
(момент включения) могут присутствовать скачки напряжения или тока 
(в соответствии с законами коммутации ток в емкости и напряжение на 
индуктивности могут изменяться скачком). В этом случае амплитуда 
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импульсной характеристики может  очень больших значений, при 
идеальном входном воздействии – бесконечных. 

Производная сигнала в программе Probe н

достигать

аходиться с помощью функ-
ции D

ся в по-
даче н

  в строке легенды 

ражения 

→ й
 большой скорости нарастания перед-

него ф

аемых по оси Х значений. Открыть 

(имя переменной), D – от английского derivative – производная. 
Другой способ получения импульсных характеристик заключает
а вход одиночного импульса единичной площади, с большой амплитудой 

и маленькой длительностью. В моделях дельта-импульс представляют им-
пульсом с конечной амплитудой, длительностью в один шаг симуляции, с 
площадью равной 1. В PSpice шаг переменный, поэтому целесообразно выби-
рать длительность импульса много меньше времени переходного процесса. 

 35. Построить графики импульсных характеристик. 
35.а. Удалить график входного сигнала. Для этого

щелкнуть выражение для графика мышью и нажать клавишу Delete. 
 35.б. Последовательно отредактировать в строке легенды вы
для всех графиков, пример: V(N1)→D(V(N1)) – четный вариант, 
I(L1) D(I(L1)) – нечетны  вариант. 

В полученном результате из-за
ронта входного импульса, производная в первый момент времени вели-

ка (для источника напряжения – 1 ГВ/с, при длительности переднего фрон-
та 1 нс и амплитуде 1 В), и на фоне этого значения менее амплитудные из-
менения не видны. Следует отмасштабировать оси таким образом, чтобы 
исключить из области построения начальный момент времени (момент 
включения), и стали заметны менее амплитудные и более информативные 
изменения импульсных характеристик. 
 35.в. Изменить диапазон отображ
окно настройки параметров сетки и осей  (Axis Settings). На закладке X Axis 
в разделе Data Range поставить флажок User Defined (определяется пользо-
вателем) и отредактировать начальное значение оси X введя 2 нс (рис. 37). 

 

 
Рис. 37. Масштабирование оси X через опции окна Axis Settings 
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Масштабные суффиксы в программе Probe немного отличаются от 
используемых в PSpice и Capture. Суффикс Мега – 106 , записывается как М, 
за суффиксом милли – 103 , закреплено m. Программа PSpice не различает 
большие и маленькие буквы. 

Для получения удовлетворительного результата, можно также ме-
тодом последовательного приближения отмасштабировать ось Y до адек-
ватного отображения графиков импульсных характеристик. 
 35.г. Сохранить графики импульсных характеристик в заготовке отчета. 5

 
Обработка экспериментальных данных 

 
Результаты компьютерного анализа схемы по постоянному току и не-

автоматизированного расчета выполненного при подготовке к работе свести 
в одну таблицу, пример: см. табл. 5. 

Определить по графикам времена переходных процессов для всех вы-
ходов. Проанализировать на взаимное соответствие частотные и временные 
характеристики. Сравнить результаты расчетов по постоянному току. 

 
Содержание отчета 

 
Цель работы, исходная схема, результаты подготовки к работе (вклю-

чая упрощенную схему, исходные соотношения, вывод формул), результаты 
анализа по постоянному току (скриншот и таблица (см. табл. 5)), скриншоты 
всех используемых в работе схем выполненных в OrCAD Capture, графики 
всех полученных характеристик, выходной и схемный файл, файл соедине-
ний, директивы анализа с параметрами, выводы по работе. 

 
Таблица 5 

 

Результаты  автоматизированного и ручного расчета емысх  по постоянному току 
 

Параметр Анализ PSpice Ручной расчет 

IR1, мА   
IR2, мА   
IC1, мА   
IC2, мА   
IL1, мА   
IE1, мА   
IE2, мА   
IY1, мА   
UA1, В   
…   
Rвх, Ом   
Rвых, Ом   
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Контрольные вопросы 
 
1. Что называется линейными элементами электрической цепи? 
2. Что называется линейной электрической цепью? 
2. Что такое идеальные источники тока и напряжения, их ВАХ? 
3. В чем заключаются отличия реальных и идеальных источников энер-

гии в цепи? Привести примеры реальных источников тока и напряжения. 
4. Каковы основные задачи частотного анализа? 
5. Каковы основные задачи переходного анализа? 
6. Каковы основные задачи статического анализа? 
8. Какие параметры задаются при настройке частотного анализа 

(PSpice)? Название частотного анализа в PSpice. 
9. Какие параметры задаются при настройке динамического анализа 

(PSpice)? Название динамического анализа в PSpice. 
10. Параметры источников VPULSE и IPULSE (PSpice). 
11. Параметры источников VAC и IAC (PSpice). 
12. Что такое переходная и импульсная характеристики цепи, их взаи-

мосвязь? 
13. Разъяснить с помощью схемы происхождение полученных величин 

тока и напряжения для всех видов анализа. 
14. Задачи, какого уровня проектирования решались в лабораторной 

работе? 
15. Какие проектные процедуры выполнялись в лабораторной работе? 
16. По характеру отображаемых свойств, какое описание РЭС исполь-

зовалось в лабораторной работе? 
17. К какому виду обеспечения САПР относиться пакет OrCAD? 
18. Определение РЭС в соответствии с ГОСТ Р 52003-2003. 
19. Директивы частотного и динамического анализа в PSpice. 
20. Дайте определение амплитудно- и фазо-частотной характеристикам. 
21. С помощью каких функций, в PSpice находиться ГПЗ, ФЧХ? 
22. Директива расчета малосигнальной передаточной функции. 
23. Расширения схемного, выходного файлов и файла соединений, их 

содержание? 
24. Как в PSpice построить АФЧХ? 
25. Как в PSpice построить переходную и импульсную характеристики? 
 



 

ЛАБОРАТОРНАЯ РАБОТА №2 
Исследование моделей полупроводниковых приборов 
 
В качестве исследуемых моделей предлагается использовать spice-

модели биполярных транзисторов общего применения фирм: NXP 
Semiconductors, ON Semiconductor и Diodes Incorporated. 

Выполнение лабораторной работы рассчитано на два занятия и состоит 
из двух частей: первая – формирование библиотеки с математической моде-
лью транзистора *.lib на основе текстового файла spice-модели от производи-
теля, получения ее вольтамперных характеристик и определения по ним и 
паспортным данным, параметров эквивалентной линейной схемы замещения 
транзистора; вторая – получение и сравнение характеристик схемы усили-
тельного каскада построенного на основе линейной модели транзистора, со 
схемой, построенной на основе spice-модели. 

 
Цель работы 

 
Изучение методики создания моделей полупроводниковых приборов с 

помощью Model Editor. 
Исследование spice-модели биполярного транзистора средствами 

OrCAD на примере усилительного каскада. 
Изучение линейной П-образной модели биполярного транзистора. 

 
Основные теоретические положения 

 
Биполярным транзистором (БТ) называется электропреобразователь-

ный полупроводниковый прибор, имеющий в своей структуре два взаимо-
действующих p-n-перехода и три внешних вывода, и предназначенный, в ча-
стности, для усиления электрических сигналов. Усилительные свойства обу-
словлены явлениями инжекции и экстракции не основных носителей заряда 
Термин “биполярный” подчеркивает тот факт, что принцип работы прибора 
основан на взаимодействии с электрическим полем частиц, имеющих как по-
ложительный, так и отрицательный заряд, – дырок и электронов. 

В зависимости от того, в каких состояниях находятся переходы транзи-
стора, различают режимы его работы. Поскольку в транзисторе имеется два 
перехода (эмиттерный и коллекторный), и каждый из них может находиться 
в двух состояниях (открытом и закрытом), различают четыре режима работы 
транзистора. Основным режимом является активный режим, при котором 
эмиттерный переход находится в открытом состоянии, а коллекторный – в 
закрытом. Транзисторы, работающие в активном режиме, используются в 
усилительных схемах. Помимо активного, выделяют инверсный режим, при 
котором эмиттерный переход закрыт, а коллекторный – открыт, режим на-
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сыщения, при котором оба перехода открыты, и режим отсечки, при кото-
ром оба перехода закрыты. 

Наряду с транзисторами n-p-n структуры, существуют транзисторы с 
симметричной ей p-n-p-структурой, в которых используется поток дырок. 
Стрелка на выводе эмиттера показывает направление эмиттерного тока в ак-
тивном режиме. Принцип работы n-p-n- и p-n-p-транзисторов одинаков, а по-
лярности напряжений между их электродами и направления токов в цепях 
электродов противоположны. 

В большинстве электрических схем транзистор используется в качестве 
четырехполюсника, то есть устройства, имеющего два входных и два выход-
ных вывода. Поскольку транзистор имеет только три вывода, для его исполь-
зования в качестве четырехполюсника необходимо один из выводов транзи-
стора сделать общим для входной и выходной цепей. Соответственно разли-
чают три схемы включения транзистора: схемы с общей базой (ОБ), общим 
эмиттером (ОЭ) и общим коллектором (ОК). 

Среди многочисленных вариантов усилительных каскадов на БТ самое 
широкое применение находит усилительный каскад с ОЭ, имеющий мак-
симальный коэффициент передачи по мощности КP . пример простого усили-
тельного каскада с ОЭ приведен на рис. П.2. 

Характеристиками транзисторов пользуются для определения режимов 
работы транзисторных каскадов по любой схеме включения, а также для 
графического анализа этих каскадов при больших сигналах. При аналитиче-
ском методе расчета транзисторных каскадов пользуются линейными экви-
валентными схемами транзисторов, которые отражают структурную связь 
малосигнальных параметров транзистора в режиме переменного тока. 

Эквивалентные схемы транзистора подразделяют на две большие группы: 
эквивалентные схемы, построенные с учетом физических свойств транзистора, 
его структуры и геометрии (модели транзистора), и эквивалентные схемы, от-
ражающие свойства транзистора как активного линейного четырехполюсника 
(формальные эквивалентные схемы). Первые характеризуются физическими 
(внутренними) параметрами транзистора, вторые – параметрами транзистора 
как четырехполюсника (характеристическими параметрами). 

Эквивалентная схема, содержащая физические параметры транзистора, 
может быть составлена для любой схемы его включения: ОБ, ОЭ, ОК. На 
рис. 38, а показана упрощенная, так называемая линейная П-образная экви-
валентная схема транзистора (модель Джиаколетто). 

В программе PSpice используется схема замещения БТ в виде адаптив-
ной модели Гуммеля-Пуна, которая включает боле 50 различных парамет-
ров. Если пользователь не располагает такими данными, то эта модель авто-
матически упрощается до более простой модели Эберса-Молла, если опус-
тить некоторые параметры. В анализе AC Sweep используются линеаризо-
ванная схема замещения, построенная на основе П-образной модели. 
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Рис. 38. Эквивалентная П-образная схема замещения БТ 

(модель Джиаколетто) 
 

Графически проиллюстрировать работу каскада с ОЭ можно, используя 
входные и выходные статические характеристики БТ, путем построения его 
динамических характеристик (ДХ). Вследствие слабой зависимости входной 
проводимости транзистора от величины нагрузки, входные статические и ди-
намические характеристики практически совпадают. 

Статические характеристики транзистора могут задаваться соответст-
вующими аналитическим выражениями, а могут быть представлены графи-
чески. Несколько характеристик одного типа, полученные при различных 
значениях параметра, образуют семейство характеристик. Семейства вход-
ных и выходных характеристик транзистора считаются основными и приво-
дятся в справочниках, с их помощью легко могут быть получены два других 
семейства характеристик. В различных схемах включения транзистора в ка-
честве входных и выходных токов и напряжений выступают токи, проте-
кающие в цепях различных электродов, и напряжения, приложенные между 
различными электродами. Поэтому конкретный вид статических характери-
стик зависит от схемы включения транзистора. 

В схеме с ОЭ входным током является ток базы Iб , а выходным – ток 
коллектора, соответственно, входным напряжением является напряжение 
Uбэ , а выходным – напряжение. 

Для съема статических характеристик БТ в PSpice используется 
DC Sweep анализ – многовариантный анализ по постоянному току. DC –
 direct current – постоянный ток. 

DC Sweep анализ позволяет получать характеристики схемы (токи, на-
пряжения, мощности) при изменении параметров источников напряжения, 
источников тока, глобальных параметров схемы, параметров модели и тем-
пературы элемента. При анализе задаются интервалы изменения перечислен-
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ных параметров, характер и шаг их изменения. Возможно также табличное 
задание изменения перечисленных параметров. Существует возможность од-
новременного изменения двух параметров. 

Выходные ДХ – это прямые линии, которые в координатах Iк , U кэ  со-
ответствуют уравнениям, выражающим зависимости между постоянными и 
переменными значениями токов и напряжений на нагрузках каскада по по-
стоянному и переменному току. Пример построения ДХ показан на рис. 39. 

 

 
Рис. 39. Динамические характеристики каскада с ОЭ 

 

Точку пересечения нагрузочной прямой со статической характеристи-
кой при заданном токе Iб2 0 I б , определяемом источником смещения Eк , на-
зывают рабочей точкой, а ее начальное положение на нагрузочной прямой 
(при отсутствии входного переменного сигнала) – точкой покоя P. Точка по-
коя определяет ток покоя выходной цепи I0к  и напряжение покоя U0к . 

Положение точки покоя определяется назначением схемы, в которой 
используется транзистор, значением и формой входного сигнала и т. д. Если, 
например, входной сигнал симметричен (на рис. 39 показан такой сигнал си-
нусоидальной формы с амплитудой входного напряжения Uбm  и амплитудой 
входного тока Iбm ), то точку покоя P выбирают примерно на середине нагру-
зочной линии. При этом в коллекторной цепи проходит ток с амплитудой 
Iкm , а на коллекторе будет напряжение с амплитудой Uкm . 

Отметим, что в режиме покоя напряжение U0б составляет десятки и 
сотни мВ (обычно 0,5…0,8 В). При подаче на вход положительной полувол-
ны синусоидального сигнала будет возрастать ток базы, а, следовательно, и 
ток коллектора. В результате напряжение на Rк  возрастет, а напряжение на 
коллекторе уменьшится, т. е. произойдет формирование отрицательной полу-
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волны выходного напряжения. Таким образом, каскад с ОЭ осуществляет ин-
версию фазы входного сигнала на 180o . 

Если координаты рабочей точки для малосигнальных усилительных 
каскадов выбирают на линейных участках входной и выходной вольтампер-
ной характеристики (ВАХ) БТ, то усилитель работает в так называемом ре-
жиме (классе) усиления А. 

Для режима усиления А важным является величина нелинейных иска-
жений. Нелинейные искажения – это изменения формы колебания, обу-
словленные нелинейностью характеристик транзистора. Простейшая количе-
ственная оценка нелинейных искажений производится с помощью коэффи-
циента гармоник: 

 

2 2 2
2 3 4Г 1K U U U U   K , 

 

где U1 , U 2 , U3  и т. д. – действующие значения напряжений отдельных гар-
моник выходного напряжения. Вместо действующих значений, можно ис-
пользовать амплитудные. Для оценки амплитуд отдельных гармоник спектра 
выходного сигнала, в программе OrCAD можно воспользоваться преобразо-
ванием Фурье, доступного в режиме анализа Time Domain. 

Другим важным параметром усилителя является коэффициент полез-
ного действия (КПД) усилителя, характеризующий экономичность расходо-
вания энергии источника питания. Чем выше КПД усилителя, тем меньше 
мощность потерь в нем, которая превращается в тепло. 

КПД каскада (КПД выходной цепи) определяется как: 
 

вых 0 кm кm 0η 0,5P P I U P  , 
 

где, P0  – мощность затрачиваемая источником питания, Pвых  – выходная 
мощность.

 
Подготовка к работе. Часть 1 

 
Ознакомиться с целями и содержанием лабораторной работы. 
Изучить теоретические сведения к работе. Дополнительная литература 

для подготовки см. [13, 14]. 
Пройти входное тестирование или опрос для допуска к лабораторной 

работе. 
Получить у преподавателя номер варианта, в соответствии с вариантом 

выбрать модель транзистора, схему и параметры схемы для анализа (Прило-
жение 2). Получить у преподавателя файл spice-модели и паспортные данные 
(datasheet) выбранного транзистора. Документация и spice-модели транзисто-
ров также доступны на сайтах производителей. 

 



 Лабораторная работа №2. Исследование моделей полупроводниковых приборов. Часть 1
Лабораторное задание

Лабораторное задание. Часть 1 
 
1. Пользуясь данными spice-модели транзистора от производителя соз-

дать с помощью PSpice Model Editor файл библиотеки графических символов 
(*.olb). 

2. Получить семейство выходных ВАХ созданной модели транзистора 
для схемы с ОЭ, построить гиперболу максимальной рассеиваемой мощно-
сти. В соответствии с заданием (Приложение 2) построить нагрузочную ха-
рактеристику, определить параметры рабочей точки ( Iк , Iб0 , Uкэ , Iк0 , Uкэ0 ), 
параметры h21э  и h22э . 

3. Получить семейство входных ВАХ созданной модели транзистора для 
схемы с ОЭ, определить параметр рабочей точки (Uбэ0 ), параметры h11э  и h12э . 

 
Порядок выполнения и рекомендации. Часть 1 

 
Создание условного графического обозначения транзистора 

средствами Model Editor 
 
1. Загрузить редактор моделей – программный модуль OrCAD PSpice 

Model Editor. 
Программа OrCAD PSpice Model Editor (редактор моделей) служит 

для создания и редактирования spice-моделей электронных компонентов, 
имеет средства, позволяет создавать новые библиотеки моделей, добав-
лять модели в уже существующие библиотеки. Model Editor имеет средства 
для привязки spice-моделей к готовым условным графическим обозначениям 
(УГО) компонентов, средства импорта моделей из других форматов. 

2. Открыть файл библиотеки spice-модели транзистора и сохранить в 
папку проекта. Команда File>Open, затем File>Save As…. Средствами Win-
dows создать папку, в которой будет размещаться проект, и сохранить в нее 
файл spice-модели (расширение файла – *.lib). 

 3. Создать и сохранить библиотеку графического символа транзистора 
в папке проекта (расширение файла – *.olb). 
 3.а. Запустить Model Import Wizard (мастер импорта моделей). В 
Model Editor команда File>Model Import Wizard [Capture]… (рис. 40). 

Spice-модель транзистора, как и любая другая spice-модель – это 
текст с определенными правилами синтаксиса – может быть представлена 
в виде совокупности параметров (директива .MODEL в начале описания мо-
дели), либо в виде списка соединений подсхемы связанных компонентов со 
встроенными моделями (директива .SUBCKT – макромодель). 

Модель БТ определенная директивой .MODEL – это набор параметров 
адаптивной модели Гуммеля-Пуна. Параметры не заданные в тексте моде-
ли, будут приняты равными значениями по умолчанию. 
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Модель, определенная директивой .SUBCKT может включать в себя 
подсхемы из моделей, не имеющих действительной физической реализации в 
компоненте, но позволяющих получить более точные результаты моделиро-
вания. Например, модель БТ может быть дополнена виртуальным диодом 
между базой и коллектором улучшающим результаты моделирования при 
обратном смещении на коллекторном переходе. 

 

 
Рис. 40. Запуск мастера импорта моделей в Model Editor 

 

 3.б. В окне мастера импорта Specify Library указать пути к библиоте-
кам *.lib и *.olb, а также название библиотеки символов, в которой будет со-
храняться УГО транзистора (рис. 41). Нажать кнопку Далее. 

 

 
Рис. 41. Мастер импорта моделей. Задание путей для библиотек 
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 3.в. В окне мастера импорта Associate/Replace Symbol нажать Associ-
ate Symbol (присоединить символ) (рис. 42). Для моделей определенных че-
рез директиву .MODEL, как правило, сопоставление корпуса происходит ав-
томатически, в этом случае перейти к п. 3.ж. 

 

 
Рис. 42. Мастер импорта моделей. Присоединение символа УГО 

 

 3.г. В окне мастера импорта Select Matching указать путь для библио-
теки содержащей УГО транзистора (рис. 43). Использовать библиотеку 
modeled.etc по адресу: \OrCAD\tools\capture\library\pspice\. 
 

 
Рис. 43. Мастер импорта моделей. Выбор библиотеки символов и сопоставление УГО 

 

Библиотека modeled.etc содержит базовый набор символов для транзи-
сторов. Можно также использовать любую библиотеку содержащую УГО БТ. 
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 3.д. В разделе Matching Symbols выбрать УГО БТ с необходимым ти-
пом проводимости (p-n-p или n-p-n) (рис. 43). Для определения типа прово-
димости нажать кнопку View Model Text (просмотр текста модели) и найти в 
открывшемся окне требуемую информацию (рис. 44). После выбора УГО 
нажать кнопку Далее. 

 

 
Рис. 44. Мастер импорта моделей. Окно просмотра текста модели 

 

 3.е. В окне мастера Define Pin Mapping сопоставить номера выводов 
назначению и нажать Save Symbol (рис. 45). Для определения назначения 
выводов просмотреть текст модели (рис. 43) и найти в открывшемся окне 
требуемую информацию (рис. 44). 
 

 
Рис. 45. Мастер импорта моделей. Окно определения выводов УГО 

 

Форма описания включения БТ: Q<имя> <узел коллектора> <узел ба-
зы> <узел эмиттера> <имя модели>. Если в тексте модели комментариями 
не определено назначение выводов, воспользоваться приведенной выше 
формой описания (рис. 46) 
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Подключение библиотек модели и символа компонента к проекту 

 
Рис. 46. Фрагмент текста модели БТ. Назначение выводов 

 

 3.ж. Нажать кнопку Готово. Просмотреть открывшийся журнал собы-
тий (Log File), удостоверится в отсутствие ошибок, нажать OK и закрыть 
Model Editor. 

 
Подключение библиотек модели и символа компонента к проекту 

 
4. Загрузить графический редактор схем – программный модуль Or-

CAD Capture (CIS). 
5. Создать проект (Analog or Mixed A/D). 

 6. Подключить к проекту библиотеки *.lib и *.olb своего транзистора. 
 6.а. Открыть окно настройки моделирования Simulation Settings. 
 6.б. На закладке Configuration Files выбрать категорию Libraries и в 
строке Filename указать путь к файлу библиотеки модели компонента (рис. 47). 
 6.в. Добавить библиотеку в проект. Щелкнуть Add to Design (рис. 47). 

 

 
Рис. 47. Подключение библиотеки модели компонента *.lib 

 

В версии OrCAD 9.2 категории Stimulus, Library и Include оформлены 
как отдельные закладки окна Simulation Settings. 
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Add as Global – делает библиотеку доступной во всех проектах. 
Add to Design – добавляет библиотеку только к текущему проекту. 
Add to Profille – делает библиотеку доступной только для этого кон-

кретного профиля моделирования. 
При использовании категории Library добавление описания модели во 

входной файл происходит по директиве .LIB. 
При изменении местоположения библиотеки, например, при переносе 

проекта на другой компьютер, следует заново указать путь к библиотеке. 
Если PSpice не найдет библиотеки в выходном файле появится сооб-

щения вида: «ERROR - Model <имя модели> used by Q_Q1 is undefined». 
Библиотеку модели можно добавить и с помощью категории Include, 

в этом случае текст файла библиотеки будет добавлен во входной файл по 
директиве .INC. 
 6.г. Открыть окно добавления компонентов (Place Part). Щелкнуть 
Add Library (рис. 48) и в открывшемся окне указать путь к файлу *.olb. 

 

 
Рис. 48. Добавление библиотеки символа компонента *.olb 

 

Значок в правой нижней части окна Place Part показывает наличие 
spice-модели для данного компонента. 

 
Построение выходных ВАХ БТ 

 
 7. Снять семейство выходных характеристик биполярного транзистора 

для схемы с ОЭ. 
 7.а. Собрать схему для съема выходных характеристик (рис. 49). 

Полярность источников зависит от полярности транзистора. 
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Рис. 49. Схема для съема выходных характеристик БТ с ОЭ 

 

 7.б. Обозначить источник базового тока – Ib, а источник напряжения 
коллектор-эмиттер – Vce. Схему сохранить в заготовке отчета. 
 7.в. Создать новый профиль моделирования. 3

 7.г. Выбрать тип анализа DC Sweep. 
 7.д. В Options выбрать Primary Sweep и задать параметры основной 
переменной. 

В качестве основной переменной (Primary Sweep) выбираем напряжение 
источника Vce, начальное значение (Start Value) можно задать равным нулю. 
Конечное значение (End Value) задать равным Uкэmax  – максимально допусти-
мому напряжению коллектор-эмиттер для данного транзистора (справочный па-
раметр, указан в datasheet на транзистор в разделе Maximum Ratings, параметр –
 Collector-Emitter Voltage), шаг (Increment) – 10 мВ. Пример показан на рис. 50. 

 

 
Рис. 50. Настройка параметров Primary Sweep. Выходные характеристики 

 

В ходе анализа DC Sweep производится серия анализов цепи по посто-
янному току, при изменении параметров источников напряжения, источни-
ков тока, глобальных параметров (например, номиналов компонентов), па-
раметров моделей или температуры. 
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 7.е. В Options выбрать Parametric Sweep и задать параметры второ-
степенной переменной. 

В качестве второстепенной или параметрической переменной (Para-
metric Sweep) выбираем ток источника Ib, начальное значение (Start Value) 
задать равным нулю. Конечное значение (End Value) задать равным 1 мА, 
шаг (Increment) – 100 мкА. Пример показан на рис. 51. 
 

 
Рис. 51. Настройка параметров Parametric Sweep. Выходные характеристики 

 

Исследуя статические характеристики при вариации какого-либо па-
раметра можно, для задания параметрической переменной также пользо-
ваться опцией Secondary Sweep, отличие заключается в том, что все семей-
ство характеристик будет построено одной линией, т. е. невозможно бу-
дет определить какому току базы соответствует какая-либо характери-
стика. 
 7.ж. На закладке Probe Window включить опцию Last plot. 
 7.з. Запустить симуляцию. 
 7.и. Построить графики выходных характеристик транзистора. Открыть 
окно Add Traces. В строку Trace Expression ввести выражение IC(Q1) – ток 
коллектора транзистора. 

Если полученный ток отрицательный, для удобства дальнейшей рабо-
ты, изменить знак перед выражением. 
 7.к. Отмасштабировать оси, так чтобы граничные отображаемые значе-
ния соответствовали Uкэmax  и Iкmax  (справочные параметры указаные в 
datasheet на транзистор). 
 7.л. Открыть выходной файл (Output File) найти и скопировать в заго-
товку отчета раздел с директивами анализа (Analysis directives). 

8. Построить гиперболу максимальной рассеиваемой мощности. От-
крыть окно Add Traces  и в строку Trace Expression ввести выражение 
Pmax/V_Vce, вместо Pmax подставить максимальную мощность рассеивания 
транзистора указанную в datasheet на транзистор. 
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9. Построить нагрузочную линию. Команда Plot>Label>Line (рис. 52). 
Нагрузочную линию провести от точки V_Vce=80%Uкэmax  на оси Х 

(V_Vce), по касательной к гиперболе мощности до пресечения с осью Y. 
 

Чтобы провести линию с помощью инстру-
мента Line, нужно мышью указать началь-
ную и конечную точки линии. 
Для удаления линии с области построения 
надо выделить линию щелчком кнопки мыши 
и нажать клавишу Delete. 

10. Изменяя параметры второстепенной 
переменной (источник Ib), масштабируя гра-
фики и при необходимости корректируя на-
грузочную линию привести построение к при-
мерному виду – рис. 53 – показан пример вы-
ходных характеристик, нагрузочной линии и 
гиперболы мощности. 

 

 
Рис. 52. Построение линии 

 
Рис. 53. Семейство выходных характеристик транзистора 

 

 11. Выбрать рабочую точку и зафиксировать с помощью режима трас-
сировки ее параметры Iк , Iб0 , Uкэ , Iк0 , Uкэ0 . 

Рабочая точка выбирается в соответствии с лабораторным  заданием. 
В режиме работы каскада А, рабочую точку выбирают на середине нагру-
зочной линии. 
 11.а. Включить режим трассировки. Команда Trace>Cursor>Display 
или щелчок соответствующего значка панели инструментов (рис. 54). 
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Рис. 54. Включение режима трассировки 

 

После вызова курсора появляется новое окно (Probe Cursor) с текущи-
ми координатами положения двух курсоров обозначенных А1 и А2 (рис. 55). 
В строке легенды графиков показывается, к какой именно диаграмме отно-
сятся операции с курсором. 
 11.б. Выбрать трассируемый график и поместить на него курсор. 

Для выбора или смены трассируемого графика нужно щелкнуть мыш-
кой по соответствующему символу графика в строке легенды (рис. 55), при 
этом щелчок левой кнопкой мыши закрепляет за графиком курсор А1, а щел-
чок правой – курсор А2. Переместить курсор с графика на график можно 
также используя сочетания клавиш Ctrl+← или Ctrl+→ (курсор А1) и 
Ctrl+Shift+← или Ctrl+Shift+← (курсор А2). 
 11.в. Навести курсор на рабочую точку, и поставить метку с координа-
тами (параметры рабочей точки – Uкэ0  и Iк0 ), команда Plot>Label>Mark или 
щелчок соответствующей пиктограммы панели инструментов (рис. 55). 
Метка будет поставлена курсору, который был перемещен последним. 

Зафиксировать в заготовке отчета значения Uкэ0  и Iк0 . 
Курсор А1 перемещается по трассируемому графику с помощью левой 

кнопки мыши или клавиш ← и →, а курсор А2 – правой, или сочетаний кла-
виш Shift+← и Shift+→. 

Для повышения точности можно воспользоваться масштабировани-
ем, увеличив интересующую область графика с помощью инструментов 
Zoom Area или Zoom In, вернуть график в исходный масштаб можно исполь-
зуя инструменты Zoom Fit, Zoom Out или заново отмасштабировав оси. 

После простановки метки, выключить трассировку и передвинуть мет-
ку мышкой на свободное пространство области построения. 
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Рис. 55. Трассировка и простановка метки с координатами 

 

Сохранить в заготовке отчета рисунок семейства выходных характери-
стик с гиперболой мощности, нагрузочной линией и обозначенной рабочей 
точкой.5 
 11.г. С помощью курсоров и показаний окна Probe Cursor определить 
координаты точек пересечения линии нагрузки с осями – параметры Iк  и Uкэ . 
Зафиксировать в заготовке отчета значения Iк  и Uкэ . 
 11.д. Определить и зафиксировать в заготовке отчета параметр Iб0 . 
Щелкнуть правой кнопкой мыши на выходную характеристику соответст-
вующую выбранной рабочей точки, щелкнуть пункт Information (рис. 56). 

Аналогичную информацию можно получить двойным щелчком по знач-
ку графика в строке легенды. 

Рис. 56. Определение значения параметрической переменной 
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 12. С помощью курсоров и показаний окна Probe Cursor определить и 
зафиксировать в заготовке отчета необходимые данные для нахождения 
h-параметров транзистора ( h21э  и h22э ). 

Пример работы по определению приращений для нахождения выход-
ных h-параметров транзистора показан на рис. 57. 

 

 
а 

 
б 

Рис. 57. Определение приращений для нахождения выходных h-параметров 
(а – , б – ) 21эh 22эh

 

В нижней строке окна Probe Cursor содержится разница между ко-
ординатами курсоров по осям X и Y. 

 
Построение входных ВАХ БТ 

 
 13. Снять семейство входных характеристик биполярного транзистора 

для схемы с ОЭ. 
 13.а. Создать новый проект (Analog or Mixed A/D), подключить биб-
лиотеку spice-модели транзистора. 
 13.б. Собрать схему для съема входных характеристик (рис. 58). 

Полярность источников  зависит от полярности транзистора. 
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Рис. 58. Схема для съема входных характеристик транзистора (OrCAD) 

 

 13.в. Обозначить источник напряжения база-коллектор – Vbe, а источ-
ник напряжения коллектор-эмиттер – Vce. Сохранить схему для съема вход-
ных характеристик в заготовке отчета. 
 13.г. Создать новый профиль моделирования. 
 13.д. Выбрать тип анализа DC Sweep. 
 13.е. В Options выбрать Primary Sweep и задать параметры основной 
переменной. 

В качестве основной переменной (Primary Sweep) выбираем напряже-
ние источника Vbe, начальное значение (Start Value) можно задать равным 
0,5 В. Конечное значение (End Value) задать равным 0,8 В, шаг 
(Increment) – 1 мВ. Пример показан на рис. 59. 

 

 
Рис. 59. Настройка параметров Primary Sweep. Входные характеристики 

 

 13.ж. В Options выбрать Parametric Sweep и задать параметры второ-
степенной переменной. 

В качестве второстепенной или параметрической переменной (Para-
metric Sweep) выбираем напряжение Vсe, начальное значение (Start Value) 
задать на 10 % меньше Uкэ0 . Конечное значение (End Value) задать на 10 % 
больше Uкэ0 , шаг – 10 % от Uкэ0 . Пример показан на рис. 60. 
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В итоге должно получиться три ветви входных ВАХ, центральная из 
которых будет соответствовать выбранной рабочей точке. Крайние вет-
ви, нужны для нахождения h-параметров. 
 13.з. Включить опцию Last plot. 

 

 
Рис. 60. Настройка параметров Parametric Sweep. Входные характеристики 

( кэ0 11,8 ВU  ) 
 

 13.и. Запустить симуляцию. 2

 13.к. Построить графики выходных характеристик транзистора. От-
крыть окно Add Traces.7 В строку Trace Expression ввести выражение 
IB(Q1) – ток базы транзистора. 

Для удобства дальнейшей работы, при необходимости изменить знак 
перед выражением. 
 13.л. Открыть выходной файл (Output File) 4 найти и скопировать в за-
готовку отчета раздел с директивами анализа (Analysis directives). 

 14. Определить и зафиксировать в заготовке отчета напряжение Uбэ0 . 
Изменяя параметры второстепенной переменной (источник Vbe) и 

масштабируя графики привести построение к такому виду, чтобы область по-
строения включала окрестность рабочей точки (точки соответствующей току 
Iб0  найденному в п. 11.д.) примерный вид графиков показан на рис. 61. 

 14.а. Включить режим трассировки.10  
 14.б. Навести курсор на рабочую точку, и поставить метку 11 (параметры 
рабочей точки – Uбэ0  и Iб0 ). Зафиксировать в заготовке отчета параметр Uбэ0 . 

После простановки метки, выключить трассировку и передвинуть мет-
ку мышкой на свободное пространство области построения. 

Сохранить в заготовке отчета рисунок семейства входных характери-
стик с обозначенной рабочей точкой. 5

15. С помощью курсоров и показаний окна Probe Cursor определить и 
зафиксировать в заготовке отчета необходимые данные для нахождения h-
параметров транзистора ( h11э  и h12э ). Пример на рис. 62. 
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Рис. 61. Входные характеристики транзистора 

 

 
а 

 
б 

Рис. 62. Определение приращений для нахождения входных h-параметров 
(а – h11э , б – h12э ) 

 

Определение параметра h12э  требует большого приближения области 
рабочей точки, поскольку кривые практически сливаются. 
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Подготовка к работе. Часть 2 
 

Рассчитать сопротивления задающие режим работы каскада по посто-
янному току. На основе проведенных в первой части работы измерений рас-
считать параметры элементов малосигнальной П-образной модели БТ поль-
зуясь любой из изученных методик. 

 
Лабораторное задание. Часть 2 

 
1. Ввести в ЭВМ два варианта анализируемой схемы: 
первый – используя библиотеки транзистора *.lib и *.olb созданные в 

PSpice Model Editor; 
второй – используя малосигнальную П–образную модель транзистора, 

рассчитанную при подготовке к работе. 
2. Произвести расчет первого варианта схемы усилительного каскада в 

рабочей точке по постоянному току. Получить значения токов в ветвях, 
напряжений в узлах и рассеиваемой на элементах мощности. 

3. Получить зависимости коэффициента передачи каскада по напряже-
нию, току и мощности от частоты для двух вариантов схемы. 

4. Получить отклики двух вариантов схемы на передний фронт прямо-
угольного импульса напряжения в области малых (от 1 до 5 мкс) и больших 
времен ( от 500 до 1000мс ), время нарастания переднего фронта –
 T1 1 нсf  , амплитуда – вхU . Определить время переходного процесса для 
двух вариантов схем. 

5. Получить эпюры напряжения и тока на входе и выходе двух вариан-
тов схем в установившемся режиме, при входном синусоидальном сигнале 
вида ( ) ( )вх sin 2U t U f tp= ⋅ , частоту сигнала f , выбрать на линейном участке 

АЧХ. Построить 3-4 периода сигнала. Определить амплитуды тока и напря-
жения на выходе. 

6. Построить 64 периода напряжения сигнала на выходе для первого 
варианта схемы и выполнить преобразование Фурье. Измерить величину 
первых гармоник с амплитудой свыше 1 мВ, ограничиться рассмотрением не 
более 10 гармоник. 

 
Порядок выполнения и рекомендации. Часть 2 

 
Ввод и подготовка схемы 

 
1. Загрузить графический редактор схем – программный модуль Or-

CAD Capture (CIS). 
2. Создать проект (Analog or Mixed A/D) и средствами Capture ввести в 

ЭВМ два варианта схемы, в соответствии лабораторным заданием. 
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В качестве источника входного воздействия использовать источник 
VPULSE, а в качестве источника питания – VDC. Каждая схема должна 
иметь отдельные источники питания и сигнала. 

3. Источники подсоединить через соединители страниц (off-page con-
nector). Команда Place>Off-Page Connector… или соответствующая пикто-
грамма панели инструментов (рис. 63). В открывшемся окне Place Off-Page 
Connector выбрать тип коннектора и присвоить имя. Коннекторам присвоить 
индивидуальные имена, например: in (вход), in1 (вход 1) и supply (питание). 
 

 
Рис. 63. Добавление соединителей страниц (off-page connector) 

 

Коннекторы служат для электрического соединения схем размещен-
ных на разных страницах проекта, но могут быть использованы и в рамках 
одной страницы. Цепям, к которым подключен коннектор, будет автома-
тически присвоен псевдоним, совпадающий с именем коннектора. 

4. Обозначить выходы схем как out и out1.12 
 5. Значение параметров источника VPULSE задать путем редакции 

свойств компонента. 
 5.а. Выделить компонент с помощью мыши, затем команда –
 Edit>Properties… или сочетание клавиш Ctrl+E (рис. 64). 

Открыть редактор свойств компонента (Property Editor) можно через 
контекстное меню, вызываемое щелчком правой кнопки мыши по выделенному 
компоненту или же двойным щелчком левой кнопки мыши по компоненту. 
 5.б. В открывшемся редакторе свойств компонента щелкнуть правой 
клавишей мыши в область таблицы и в открывшемся контекстном меню вы-
брать Pivot (рис. 65). 
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Опция Pivot контекстного меню редактора свойств меняет способ 
отображения таблицы параметров компонента. 

 

 
Рис. 64. Запуск редактора свойств компонента 

 

 
Рис. 65. Редактора свойств компонента. Изменение способа отображения таблицы 

 

 5.в. Параметры источника задать, как показано в таб. 6. 
Ввод параметра АС позволяет использовать данный источник для ча-

стотного анализа (AC Sweep). Применение в spice-моделировании специали-
зированных источников типа VAC и VDC обусловлено отсутствием необхо-
димости вводить большое число параметров, что удобно, если планируется 
проводить только один вид анализа. 

Таблица 6 
Параметры источника VPULSE 

 

Параметр AC V1 V2 TD TR TF PW PER 
Значение U  вх

0 U  вх 0 1 нс 1 нс 2 с 3 с 
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 5.г. Для источника VPULSE отобразить на схеме параметр AC. 
Правой кнопкой мыши щелкнуть по ячейке со значением параметра АС и 

выбрать в контекстном меню пункт Display…, затем в открывшемся окне Dis-
play Properties установить флажок Name and Value как показано на рис. 66. 

6. Для управляемого источника тока используемого в схеме замещения 
биполярного транзистора задать и отобразить параметр GAIN на схеме. 

Параметр GAIN в OrCAD – это коэффициент передачи управляемого 
источника. Для ИТУН (в OrCAD – G), GAIN представляет собой передаточ-
ную проводимость, в модели БТ Джиаколетто – крутизна транзистора. 

При использовании ИТУТ (в OrCAD – F), GAIN – коэффициент переда-
чи по току, в модели Джиаколетто – параметр h21. 

Итоговая схема в OrCAD может выглядеть, как показано на рис. 67. 
 

 

 

Рис. 66. Отображение на схеме параметров компонентов 
 

В схеме на рис. 67 (б) для построения модели Джиаколетто использо-
ван ИТУН, при использовании ИТУТ П-образная схема замещения транзи-
стора может выглядеть, как показано на рис. 68. 
 

Анализ по постоянному току 
 
7. Создать новый профиль моделирования. 3

8. Выбрать тип анализа AC Sweep – анализ схемы в частотной области. 
Начальную частоту задать равной 0.1 Гц, конечную – 10 ГГц, число точек на 
декаду – 50. 

9. Включить опцию Last plot. 
10. Запустить симуляцию. 2

11. Включить отображение на схеме режима по постоянному току, 
включая отображение потребляемых мощностей.13 Передвинуть с помощью 
мыши отобразившиеся значения токов и напряжений так, что бы схема имела 
читаемый вид. 
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Анализ по постоянному току

 

Рис. 67. Схемы усилительных каскадов (OrCAD) на основе на транзистора (а) и П-
образной схемы замещения с использованием ИТУН (б) 

 

 

Рис. 68. П-образная схема замещения БТ с использованием ИТУТ (OrCAD) 
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 Лабораторная работа №2. Исследование моделей полупроводниковых приборов. Часть 2
Частотный анализ

В программе PSpice (если специально не отключать) расчет схемы по 
постоянному току происходит перед частотным и динамическим анализом, 
поэтому если нет нужды в какой-то специфической информации о режиме 
работы по постоянному току, можно статический анализ делать совмест-
но с другими видами анализа. 

12. Сделать скриншот первого варианта схемы с результатами анализа и 
ввести полученные данные в заготовку отчета. 

 
Частотный анализ 

 
13. Построить графики АЧХ напряжения для двух схем. Открыть окно 

Add Traces  и в строку Trace Expression через пробел ввести выражения для 
двух графиков, например V(OUT)/V(IN) и V(OUT1)/V(IN1). 

14. Проанализировать вид полученных АЧХ. Если требуется, открыть 
настройки профиля моделирования (Simulation Settings)  и изменить, гра-
ничные частоты анализа, число точек таким образом, чтобы графики приоб-
рели наиболее информативный вид. Если внесены изменения в профиль мо-
делирования, запустить симуляцию. 

15. Зафиксировать максимальное значение АЧХ напряжения. Включить 
трассировку,  щелкнуть значок Max панели инструментов и поставить метку  
на каждый график (рис. 69). 

 

 
Рис. 69. Поиск максимума характеристики с помощью средств трассировки 

 

16. Сохранить графики АЧХ напряжения в буфер обмена. 
17. Построить графики АЧХ тока для двух схем. Открыть окно Add 

Traces  и в строку Trace Expression ввести выражение отношение токов вы-
ходной и входной емкостей, например I(C2)/I(C1) и I(C4)/I(C3). 
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 Лабораторная работа №2. Исследование моделей полупроводниковых приборов. Часть 2
Временной анализ. Переходные характеристики 

18. Выполнить действия по пп. 15 и 16. 
19. Построить графики АЧХ мощности для двух схем. Открыть окно 

Add Traces  и в строку Trace Expression ввести выражения для коэффициен-
тов передачи по мощности. 

Зависимость коэффициента передачи по мощности от частоты, 
можно получить, перемножив коэффициенты передачи по току и напряже-
нию или поделив мощность, выделяемую в нагрузку на мощность отдавае-
мую источником сигнала  

20. Выполнить действия по пп. 15 и 16. 
21. Открыть выходной файл (Output File)  найти и скопировать в заго-

товку отчета раздел с директивами анализа (Analysis directives). 
 

Временной анализ. 
Переходные характеристики в области больших времен 

 
22. Создать новый профиль моделирования. 
23. Выбрать тип анализа Time Domain. 
24. Настроить параметры анализа в соответствии с п. 4 лабораторного 

задания, время анализа – 500 мс. 
25. Включить опцию Last plot. 
26. Запустить симуляцию. 
27. Построить переходные характеристики для обеих схем. Открыть 

окно Add Traces. В строку Trace Expression ввести выражения для двух от-
кликов, например V(OUT) и V(OUT1). 

28. Проанализировать вид полученных характеристик. При необходи-
мости, открыть настройки моделирования (Simulation Settings)  и скорректи-
ровать время анализа, максимальный шаг, запустить симуляцию еще раз. 

 

 
Рис. 70.Переходные характеристики. Время анализа – 1000 мс 
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 Лабораторная работа №2. Исследование моделей полупроводниковых приборов. Часть 2
Временной анализ. Отклики на синусоидальное воздействие 

29. Определить и зафиксировать в заготовке отчета примерное время 
переходного процесса. 

Примерный вид переходных характеристик в области больших времен 
показан на рис. 70. 

30. Сохранить графики откликов в буфер обмена  и вставить в заготов-
ку отчета. 

31. Открыть выходной файл (Output File) и скопировать в заготовку 
отчета раздел с директивами анализа (Analysis directives). 

 
Временной анализ. 

Переходные характеристики в области малых времен 
 
32. Открыть окно Simulation Settings  и настроить параметры анализа в 

соответствии с п. 4 лабораторного задания, время анализа – 5 мкс. 
33. Выполнить действия по пп. 26-31. 
Примерный вид переходных характеристик в области малых времен 

показан на рис. 71. 
 

 
Рис. 71.Переходные характеристики. Время анализа – 1 мкс 

 

 
Временной анализ. 

Отклики на синусоидальное воздействие в установившемся режиме 
 
34. Преобразовать схему в соответствии с п. 5 лабораторного задания. 

Вместо источника входного воздействия поставить источник VSIN. Пара-
метры источника задать, как показано в табл. 7. 

Источник VSIN позволяет задавать воздействие в виде гармоническо-
го сигнала, применяется в динамическом анализе, при задании соответст-
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Временной анализ. Отклики на синусоидальное воздействие 

вующих параметров может использоваться в частотном анализе и анализе 
по постоянному току. 

 
Таблица 7 

 

Значения параметров источника VSIN 
 

Параметр Значение Примечание 

VOFF 0 Смещение (постоянная составляющая сигнала) 

VAMPL 
вхU  Амплитуда колебания 

FREQ f  Частота сигнала. Выбрать частоту, из диапазона, в пределах 
которого АЧХ каскада по напряжению линейна 

 
35. Создать новый профиль моделирования. 
36. Выбрать тип анализа Time Domain. Параметр Start saving data af-

ter задать равным времени переходного процесса определенного в п. 29, об-
щее время анализа задать равным времени переходного процесса плюс 3-4 
периода входного сигнала, максимальный шаг ограничить такой величиной, 
чтоб на один период колебания приходилось 25-50 точек. 

В итоге на экране должны отобразиться последние 3-4 периода коле-
бания, что примерно будет соответствовать колебаниям в установившем-
ся режиме. Не менее 25 точек на период гармонического колебания – условие 
получения относительно гладких и точных графиков. 

37. Включить опцию Last plot. 
38. Запустить симуляцию. 
39. Построить эпюры напряжения на выходе обеих схем. Открыть окно 

Add Traces. В строку Trace Expression ввести выражения для двух откликов, 
например V(OUT) и V(OUT1). 

40. Добавить дополнительную ось Y на график. Команда Plot>Add Y 
Axis или сочетание клавиш Ctrl+Y (рис. 72). 

За первой осью закрепляется номер 1. По мере добавления осей, новые 
нумеруются в порядке возрастания – 2, 3, 4 и т. д. 

Удалить ось можно командой Plot>Delete Add Y. 
41. Выбрать новую ось Y щелкнув мышью по оси номер 2. 
Выбранная в данный момент ось помечается значком >> (рис. 72). 
42. Построить эпюр напряжения на входе каскада. Открыть окно Add 

Traces.  В строку Trace Expression ввести выражения для входного сигнала, 
например V(IN). 

43. Включить трассировку , определить и зафиксировать в заготовке 
отчета амплитуду напряжения на выходе схемы. 

44. Сохранить графики откликов в буфер обмена  и вставить в заготов-
ку отчета. 
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Временной анализ. Отклики на синусоидальное воздействие. Анализ Фурье

 
Рис. 72. Добавление новой оси Y 

 

45. В PSpice A/D создать новое окно 14 и выполнить пп. 39-44 для вы-
ходных токов. 

46. Открыть выходной файл (Output File)  найти и скопировать в заго-
товку отчета раздел с директивами анализа (Analysis directives). 

 
Временной анализ. 

Отклики на синусоидальное воздействие. Анализ Фурье 
 
47. Создать новый профиль моделирования. 
48. Выбрать тип анализа Time Domain. Параметр Start saving data af-

ter задать равным времени переходного процесса определенного в п. 29, об-
щее время анализа задать равным времени переходного процесса плюс 64 пе-
риода входного сигнала, максимальный шаг ограничить такой величиной, 
чтоб на один период колебания приходилось 100-200 точек. 

Для спектрального анализа периодических сигналов с помощью пре-
образования Фурье в программе PSpice A/D, важно чтобы было рассчи-
тано целое число периодов смоделированной функции. При вычислении 
быстрого преобразования Фурье (БПФ) программа PSpice A/D исходит из 
того, что рассчитанный интервал полученной функции периодически  
повторяется. При необходимости, при расчете исходной функции следу-
ет ограничивать величину максимального шага интегрирования, точ-
ность расчета в данном случае напрямую влияет на точность спек-
трального анализа. 

Интервал анализа для преобразования Фурье, в пределах установлен-
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Временной анализ. Отклики на синусоидальное воздействие. Анализ Фурье

ных директивой моделирования, также можно задать в свойствах оси X 
окна Axis Settings, группа Use Data, флажок Restricted (analog). Разрешение 
по частоте равно 1 T , где Т – интервал анализа. 

49. Включить опцию Last plot. 2

50. Запустить симуляцию. 
51. Построить эпюр напряжения на выходе каскада построенного на ос-

нове spice-модели БТ. Открыть окно Add Traces 7 и в строку Trace Expression 
ввести выражения для отклика первого варианта схемы, например V(OUT). 

52. Выполнить преобразование Фурье. Команда Trace>Fourier или со-
ответствующая кнопка на панели инструментов (рис. 73). 6

Преобразование Фурье можно выполнить, поставив флажок Fourier 
группы Processing Options в свойствах оси X окна Axis Settings. 

53. Установить для оси Y логарифмический масштаб и отмасштабиро-
вать ось так, чтобы нижняя граница была рана 100 мкВ (рис. 73). Если необ-
ходимо, отмасштабировать ось X. 

Возможное присутствие нулевой гармоник в спектре, в основном, обу-
словлено наличием постоянной составляющей в сигнале, т.е. переходной 
процесс не завершен полностью. 

 

 
Рис. 73. Преобразование Фурье в PSpice A/D 
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54. Включить трассировку 10 и определить величины первых гармоник 
(использовать не более 10 шт.) амплитуды которых превышают 1 мВ, поста-
вить метки.11 Измеренные значения и полученный график сохранить в заго-
товке отчета. Примерный вид полученного спектра колебания на выходе 
усилителя с измеренными амплитудами гармоник показан на рис. 74. 



 Лабораторная работа №2. Исследование моделей полупроводниковых приборов. Часть 2
Обработка экспериментальных данных

В программе PSpice A/D существует возможность представить ре-
зультаты анализа Фурье в табличной форме, записав их в выходной файл. 
Это можно сделать, введя в схемный файл директиву .FOUR. В выходной 
файл будут записаны величины гармоник амплитудного и фазового спектра, 
их нормированные значения, а также коэффициент гармоник. 

Директива .FOUR в OrCAD вводиться через опции настроек модели-
рования окна Simulation Settings, тип анализа – Time Domain. Нажать 
кнопку Output File Options…, в открывшемся окне (Transient Output File Op-
tions) поставить флажок Perform Fourier Analysis, указать частоту первой 
гармоники (фундаментальную частоту колебания), количество гармоник для 
расчета (по умолчанию 9) и выходную переменную. По директиве .FOUR 
спектральному анализу подвергается участок реализации переходного про-
цесса в конце интервала анализа длительностью равной 1 f , где f – частота 
первой гармоники. 

 

 
Рис. 74. Спектр колебания на выходе усилителя 

 

Обработка экспериментальных данных 
 

Для первого варианта схемы рассчитать КПД выходной цепи усили-
тельного каскада и коэффициент гармоник. 

Проанализировать на взаимное соответствие характеристики для двух 
вариантов схемы усилительного каскада. 
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55. Открыть выходной файл (Output File) 4 найти и скопировать в заго-
товку отчета раздел с директивами анализа (Analysis directives). 



 Лабораторная работа №2. Исследование моделей полупроводниковых приборов. Часть 2
Содержание отчета. Контрольные вопросы

Содержание отчета 
 
Цель работы, исходная схема, результаты подготовки к работе (расчет 

сопротивлений каскада, расчет модели транзистора Джиаколетто, исходные со-
отношения и пояснения к расчетам), скриншоты всех используемых в работе 
схем выполненных в OrCAD Capture, результаты анализа по постоянному току 
(скриншот и таблица (см. табл. 5)), графики всех полученных характеристик и 
зависимостей, все измеренные или рассчитанные параметры, выводы по работе. 

 
Контрольные вопросы 

 
1. Линейная П-образная малосигнальная модель БТ. 
2. Физический смысл элементов модели БТ Джиаколетто. 
3. Почему модель БТ Джиаколетто линейная и малосигнальная? 
4. Как определяется рабочая точка усилительного каскада? 
5. Частотные свойства биполярного транзистора на примере П-

образной модели Джиаколетто. 
6. Какие модели БТ используется в PSpice? 
7. Какие модели полупроводниковых элементов используются в час-

тотном анализе? 
8. Какой анализ PSpice использовался для получения ВАХ БТ, его ди-

ректива? 
9. Типы управляемых источников и их параметры. 
10. Параметры источника VSIN. 
11. Как называется модуль пакета OrCAD в котором создаются и ре-

дактируются spice-модели? 
12. Как называется модуль пакета OrCAD в котором выполняется по-

строение графиков и анализ результатов моделирования схем? 
13. Какие элементы схемы определяют частотные свойства каскада? 
14. Что и как сделали, получили в лабораторной работе? 
15. Инструмент Probe, с помощью которого определялись приращения 

для расчета h-параметров? 
16. Директива, предваряющая описание spice-модели в виде совокуп-

ности параметров. Директива, задающая описание макромодели. 
17. Какие библиотеки OrCAD использовались в лабораторной работе? 
18. Какие библиотеки были подключены для выполнения работы? 
19. Расширение библиотек OrCAD spiсe-модели и УГО? 
20. Опцией, какого анализа в PSpice является анализ Фурье?

 
 

Основы компьютерного проектирования и моделирования РЭС 
Лабораторный практикум 74



 

ЛАБОРАТОРНАЯ РАБОТА №3 
Исследование шумовых и температурных свойств 
усилительного каскада на биполярном транзисторе 

 
Цель работы 

 
Освоение методики учета шумовых свойств радиоэлектронных компо-

нентов с помощью средств OrCAD. 
Изучение шумовых свойств радиоэлектронных компонентов на приме-

ре усилительного каскада построенного на основе схемы включения бипо-
лярного транзистора с ОЭ со стабилизацией тока базы. 

 
Основные теоретические положения 

 
Шумы в электронных устройствах обычно рассматриваются как вред-

ный фактор, и, действительно, они часто накладывают ограничения на работу 
устройств. Шум характеризуется своим частотным спектром, распределени-
ем амплитуды и источником (происхождением). 

Наиболее часто встречающимися разновидностями шумов являются 
тепловой и дробовой. 

Тепловой шум возникает вследствие случайных флуктуаций скорости 
носителей заряда в резистивном материале. Это явление аналогично бро-
уновскому движению. 

Электроны в резисторе обладают тепловой энергией и передвигаются в 
материале случайным образом, испытывая в процессе движения соударения с 
атомами кристалла. Случайные движения вызывают тепловой шум. У рези-
стора, который находиться в тепловом равновесии со своим окружением, на 
концах появляются флуктуации либо напряжения (при разомкнутом конту-
ре), либо тока (при короткозамкнутом контуре). Этот шум впервые наблюдал 
Джонсон и поэтому тепловым шум еще называют шумом Джонсона.

Флуктуации можно истолковать как результат очень большого числа не-
зависимых случайных событий. Каждое событие состоит из начальной стадии, 
когда происходит отклонение от состояния равновесия, и релаксации к этому 
состоянию. Начальная стадия – это пробег электрона между столкновениями, 
который порождает неравновесное распределение заряда в резистивном мате-
риале, а релаксация – это последующее изменение заряда, восстанавливающее 
состояние равновесия. Явления, происходящие в событии, приводят к возник-
новению импульса тока или напряжения на клеммах, и суперпозиция всех та-
ких импульсов есть флуктуации теплового шума. В соответствии с этой моде-
лью тепловой шум является одним из примеров последовательности случай-
ных импульсов, и форма сигнала тока или напряжения теплового шума долж-
на состоять из очень большого числа отдельных импульсов, связанных с дис-
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кретными событиями, происходящими в резистивном материале. 
Тепловой шум – это внутреннее присущее и неустранимое свойство ре-

зистивных материалов и часто принципиально является тем пределом, ниже 
которого нельзя ослабить шумы в электронном приборе. Самый дорогой и 
тщательно изготовленный резистор имеет тот же тепловой шум, что и деше-
вый углеродный резистор с тем же сопротивлением. Общая величина шума 
пропорциональна квадратному корню сопротивления, поэтому для уменьше-
ния шума, величину сопротивлений в схеме надо также уменьшать. 

Амплитуда напряжения шума Джонсона, вообще говоря, в данный 
конкретный момент непредсказуема, но она подчиняется закону распределе-
ния Гаусса. 

Тепловой шум имеет равномерный частотный спектр, т. е. мощность 
шума одинакова на всех частотах (до некоторого предела ). Шум с равномер-
ным спектром называют «белым шумом». 

Интересно отметить, что любой физический аналог сопротивления 
(любой механизм потерь энергии в физической системе, например, вязкое 
трение малых частиц жидкости) имеет связанные с ним флуктуации соответ-
ствующей физической величины (в приведенном примере – это флуктуации 
скоростей частиц, проявляющиеся как хаотическое броуновское движение). 
Шум Джонсона – это просто специальный случай такого флуктуационно-
диссипативного явления. 

Дробовой шум связан с прохождением тока через барьер. Впервые он 
был рассмотрен Шотки, который использовал аналогию мелкой дроби сып-
лющейся в контейнер. Дробовой шум или, по крайней мере, шум, похожий на 
дробовой, часто встречается в твердотельных устройствах, где ток проходит 
через потенциальный барьер (например, в обедненном слое p-n-контакта). 

В электронной лампе акты вылета электронов с катода или попадания 
их на анод образуют последовательность независимых событий, происходя-
щих в случайные моменты времени. Поэтому ток, протекающий через нее, 
флуктуирует. То же самое происходит в транзисторе или полупроводниковом 
диоде, так как прохождение носителей через потенциальные барьеры осуще-
ствляется независимо в случайные моменты времени. Это явление и называ-
ют дробовым шумом. Таким образом, специфическая особенность дробового 
шума – физическое разделение двух областей: области, где случайно рожда-
ются носители тока (катод, эмиттер или база), и области, где они взаимодей-
ствуют с внешним электрическим полем. 

Этот вид шумов вызван дискретной природой носителей заряда. Точно 
так же, если по проводнику течет постоянный ток, то среднее число носителей 
заряда, протекающее по нему в единицу времени, постоянно. В то же время в 
каждый момент времени число носителей заряда статистически изменяется. 
Это вызывает флуктуации тока. Такое явление называют дробовым эффектом 
по аналогии с ударами дроби, падающей на металлическую пластину. 
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При низких частотах спектральная плотность тока постоянна и эффек-
тивный шумовой ток не зависит от частоты (является белым шумом). Эффек-
тивный шумовой ток пропорционален величине среднего тока и не зависит 
от температуры окружающей среды. 

Частный случай дробового шума – генерационно-рекомбинационный 
шум в полупроводниковых приборах. Генерационно-рекомбинационный шум 
наблюдается в основном в полупроводниковых средах и обусловлен флук-
туациями концентрации носителей в результате статистического характера 
актов генерации и рекомбинации. 

Физическая природа теплового и дробового шума различна, но струк-
тура шумовых сигналов обоих типов похожа: оба сигнала можно представить 
как последовательность случайных импульсов, похожих по форме и случай-
но распределенных во времени. 

Один из видов шума, встречающегося в самых разнообразных системах 
(электронных, биологических, музыкальных и т. д.), и особенно твердотель-
ных устройствах, приобрел широкую известность. Это является следствием 
повсеместного распространения и одновременно сложности для теоретиче-
ского изучения. Этот шум называется 1 f -шум, название связано с тем, что 
спектральная плотность этого шума изменяется в зависимости от частоты как 

f
α

, где значение α  обычно колеблется в пределах 0,8-1,2. Эту зависимость 

наблюдают при понижении частоты до значения порядка 106Гц. Верхний ее 
предел установить трудно, так как он, как правило, маскируется тепловым 
или каким-либо другим шумом. Другие названия 1 f -шума (исторически) –
это: токовый шум; избыточный шум; фликер-шум; контактный шум и ино-
гда называется «розовым шумом». 

Отметим, что хотя термин 1 f -шума является общим большого числа 
явлений, из этого вовсе не следует, что существует один общий для всех этих 
случаев физический механизм возникновения шума такого типа. На самом 
деле имеющиеся данные дают возможность полагать, что причина возникно-
вения 1 f -шума в различных случаях совершенно разная. В настоящее время 
не существует ни одного вполне удовлетворительного объяснения этого яв-
ления, хотя в некоторых условиях модели были получены. 

Разновидностью 1 f -шума является наблюдаемый в полупроводниках 
импульсный (взрывной) шум – ступенчатые изменения уровня сигнала со 
случайно распределенными интервалами времени между изменениями уровня. 

Анализ шумов в программе PSpice является составной частью частот-
ного анализа (AC Sweep). 

Анализ шумов позволяет рассчитывать входную и выходную спек-
тральные плотности шумов. Анализ производится от источника переменного 
тока или напряжения, для которого указываются амплитудное значение пе-
ременной составляющей и величина постоянной составляющей (в частном 
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случае может быть принята равной нулю). При анализе задаются элемент, на 
котором будет рассматриваться выходное напряжение шумов, наименование 
используемого источника и интервал расчета парциальных уровней шума. 

Результатом анализа являются кривые спектральных плотностей. При 
анализе шумов PSpice рассчитывает и выдает следующую информацию для 
каждой частоты, для которой производится анализ по переменному току: 

● шум, генерируемый на выходе некоторого устройства, который скла-
дывается из шумов, генерируемых каждым резистором и полупроводником, 
из которых состоит данное устройство. Для полупроводникового устройства 
составляющая шума определяется режимами его работы; 

● общий выходной и эквивалентный входной шум. 
При вычислении полного шума на выходе цепи PSpice вычисляет сред-

неквадратичную сумму шумов, генерируемых всеми «шумящими» элемента-
ми данной цепи. 

При вычислении эквивалентного входного шума PSpice делит общий 
выходной шум на шум, который распространяется по анализируемой цепи от 
входа к выходу. Этот результат получается при определении входного шума, 
который обеспечивает на выходе эквивалентный расчетный выходной шум в 
случае идеальной (не шумящей) цепи. 

 
Таблица 8 

 

Обозначение типов шумов аналоговых элементов (PSpice) 
 

Обозначение шума Тип шума 
NFIB(device_name) Фликкер-шум компонента 
NRB, NRC, NRE Тепловой (Джонсоновский шум) шум объемных 

сопротивлений базы, коллектора и эмиттера 
NSIB, NSIC Дробовой шум тока базы и коллектора 
NTOT(device_name) Суммарный шум компонента 

 
Наиболее удобной характеристикой шума для многих приложений яв-

ляется отношение сигнал/шум. По значению этого параметра можно судить 
о степени «засоренности» полезного сигнала шумом. Параметр сигнал/шум 
представляет собой отношение напряжения сигнала к напряжению шума, 
выраженное в децибелах. Например, если напряжение полезного сигнала –
1В, а напряжение шума – 1 мВ, отношение сигнал/шум будет составлять 
1000:1, или 60 дБ. 

В звуковых системах, чем больше значение сигнал/шум, тем более чис-
тый звук обеспечивают колонки. Желательно, чтобы этот параметр был не 
менее 75 дБ. Для мощных колонок, претендующих на высококлассное звуча-
ние, отношение сигнал/шум должно быть не меньше 90 дБ. Величина (60-
65 дБ) характерна для «кассетной» записи. Повышение отношения сиг-
нал/шум на 10 дБ означает снижение громкости шума вдвое. 
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Подготовка к работе. Лабораторное задание

Подготовка к работе 
 

Ознакомиться с целями и содержанием лабораторной работы. 
Изучить теоретические сведения к работе. Дополнительная литература 

для подготовки см. [7, 13, 14]. 
Пройти входное тестирование или опрос для допуска к лабораторной 

работе. 
Исходная схема для анализа приведена в Приложении 3, в соответст-

вии с вариантом (тот же что и в лабораторной работе №2) выбрать номинал 
внутреннего сопротивления источника входного сигнала (Приложение 3), 
остальные параметры схемы по Приложению 2 и лабораторной работе №2. 

Вычислить номинал емкости при условии, что температура возрастет 
на 2 , начальный номинал и ТКЕ по 0 Co табл. 9. 

 
Таблица 9 

 

Вариант 1, 8, 15 2, 9, 16 3, 10, 17 4, 11, 18 5, 12, 19 6, 13, 20 7, 14, 21 
С, пФ 100 50 20 15 10 5 1 
ТКЕ, % 5 10 15 20 25 30 35 

 
Лабораторное задание 

 
1. Собрать в OrCAD Capture анализируемую схему используя библио-

теки транзистора *.lib и *.olb созданные в PSpice Model Editor. 
2. Снять АЧХ каскада. Получить зависимость напряжения шумов на 

выходе каскада от частоты, а так же зависимость отношения сигнал/шум от 
частоты. 

3. Исследовать спектральные плотности шума для всех источников 
шума в схеме, отдельно для транзистора и остальных компонентов схемы, 
выявить элементы, дающие наибольший и наименьший вклад в суммарное 
напряжение шумов. 

4. Исследовать зависимости АЧХ и отношения сигнал/шум каскада от 
температуры. Температурный коэффициент резисторов (ТКС) принять рав-
ным 0,0005, емкостей (ТКЕ) принять равным 0,009. Температуру менять в 
пределах рабочего диапазона транзистора, для расчета температурных зави-
симостей взять пять отсчетов, включая комнатную температуру, и темпера-
туры на границах диапазона. 

5. Построить зависимости отношения сигнал/шум, коэффициента пере-
дачи по напряжению и ширины полосы пропускания от температуры. Для 
построения графиков использовать не менее десяти точек. 
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Ввод и подготовка схемы

Порядок выполнения работы и рекомендации 
 

Ввод и подготовка схемы 
 

1. Загрузить графический редактор схем – программный модуль Or-
CAD Capture (CIS). 

2. Создать проект (Analog or Mixed-Signal Circuit Project) и средства-
ми Capture ввести схему, соответствующую своему варианту, в ЭВМ. 

Источник входного сигнала – VAC, источник питания – VDC. 
3. Обозначить входы и выходы схемы. 
Источники подсоединить с помощью контактов питания VCC из биб-

лиотеки CAPSYM.OLB. Команда Place>Power…, соответствующая пикто-
грамма панели инструментов (рис. 75) или клавиша F на клавиатуре. В от-
крывшемся окне Place Power выбрать элемент VCC (контакт питания) и 
присвоить имя. Контактам присвоить индивидуальные имена, например: in 
(вход) и supply (питание). 

Отличие схемы усилительного каскада от схемы, использованной в ла-
бораторной работе №2, заключается в добавочном сопротивлении, имити-
рующем внутреннее сопротивление источника сигнала. 

Обратить внимание на то, что вход каскада – это точка узел между 
внутренним сопротивлением и разделительным конденсатором. 

Имена контактов автоматически закрепляются как псевдонимы це-
пей, к которым подключены. 
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Рис. 75. Добавление контактов VCC 

 

Обозначить выход схемы как out.12 
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Основы компьютерного проектирования и моделирования РЭС 
Лабораторный практикум 81

Анализ шумов 

6. Запустить симуляцию. 
7. Построить АЧХ каскада по напряжению. Открыть окно Add Traces. 

В строку Trace Expression ввести выражения для коэффициентов передачи 
по напряжению. 

 8. Построить и сохранить зависимость напряжения шумов каскада от 
частоты. 
 8.а. Создать и выбрать вторую ось координат Y.15 

V(ONOISE), от out noise – спектральное распределение шумового на-
пряжения в той точке схеме, которая при предварительной установке была 
указано как выход. 

Обозначение ONOISE относится к полной мощности выходного шума,  
NTOT(ONOISE) – спектральная плотность мощности выходного шума, име-

ет размерностьВ Г2 ц , соответственно V  ONOISE  NTOT ONOISE  , 

измеряется в В Гц . 



 
Рис. 76. Настройка анализа шумов 

Создат 3
 4. ь новый профиль моделирования.  
 5. Выбрать тип анализа AC Sweep, настроить параметры для съема АЧХ. 

В разделе окна Noise Analysis установить флажок Enabled (разрешить анализ 
шумов). В поле Output Voltage (выходное напряжение – для какой точки схе-
мы произвести анализ шумов) указать напряжение на выходе каскада. В поле 
I/V Source (источник, для которого вычисляется эквивалентный входной шум) 
указать обозначение входного источника. Пример показан на рис. 76. 

2

 8.б. Открыть окно Add Traces 7 и в строку Trace Expressions ввести 
выражение V(ONOISE) (рис. 77). 
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 8.в. Сохранить графики характеристик в заготовке отчета. Пример АЧХ 
и зависимости напряжения шумов каскада показан на рис. 78. 

 

 

рать ненужные переменные из раздела Simulation Output V

Рис. 77. Ввод выражения для спектра шумового напряжения на выходе 
 

Уб ariables 
окна Add Traces можно сняв соответствующие флажки групп переменных в 
средней части окна (рис. 77). 

 

 
Рис. 78. АЧХ и зависимость напряжения шумов на выходе каскада от частоты
 

9. Построить зависимость отношения сигнал/шум от частоты в децибе-
лах. Открыть окно Add Traces. В строку Trace Expressions ввести выраже-
ние DB(V(OUT)/V(ONOISE)). 

Вычисление децибел в программе Probe происходит с помощью функ-
ции DB(имя переменной), DB – от английского decibel – децибел. 

10. Сохранить графики характеристик в заготовке отчета. 

5

5
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Рис. 79. Спектральные плотности шумов 

а – шумы транзистора, б – шумы резисторов и суммарный шум транзистора
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 11. Построить спектральные плотности шумов для различных источни-
ков шума в схеме. Пример на рис. 79. 
 11.а. В PSpice создать новое окно.14 
 11.б. Открыть окно Add Traces.7 В строку Trace Expressions ввести 
выражения для спектральных плотностей NFIB(Q1) NRB(Q1) NRC(Q1) 
NRE(Q1) NSIB(Q1) NSIC(Q1). 
 11.в. Изменить масштаб оси Y на логарифмический.16 
 11.г. Удалить графики, имеющие только нулевые или близкие к нулю 
(порядка 3010 ) значения. 

Многие модели транзисторов не имеют коэффициентов для расчета 

фликер-шума. 

 11.д. Сохранить графики шумов транзистора в заготовке отчета. 
 11.е. В PSpice создать новое окно.14 
 11.ж. Открыть окно Add Traces.7 В строку Trace Expressions ввести 
выражения для спектральных плотностей, всех резисторов и суммарного 
шума транзистора, например, NTOT(Rb) NTOT(Rk) NTOT(Rn) NTOT(Rvn). 

Емкости и индуктивности в PSpice не имеют шумовых моделей. 
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13. Замен  и Rbreak из 
библиотеки BREAKOUT. 

ияния температуры в программе OrCAD (до версии 
16.0 в

 
pice Model (рис. 80). 

 

 
Температурный анализ. Подготовка схемы 

 
ить пассивные компоненты С и R на Cbreak

В OrCAD параметры компонентов C и R никак не зависят от темпера-
туры. Для исследования вл

ключительно) необходимо использовать компоненты Cbreak и Rbreak, 
которым можно задать температурные коэффициенты номиналов. 

 14. Задать температурный коэффициент номиналов сопротивлений и 
емкостей в соответствии с п. 4 лабораторного задания. 

14.а. Выбрать элемент, затем команда Edit>Pspice Model или щелкнуть 
правой кнопкой и из контекстного меню выбрать Edit P
 14.б. В открывшемся редакторе моделей (PSpice Model Editor), после 
номинала элемента, через пробел, ввести TC1=0.0005 – для резисторов и
TC1=0.009 – для конденсаторов, пример см. рис. 81. 
 14.в. Сохранить изменения в моделях. 

Введенный температурный компонент 
измениться одновременно у всех элемен-
тов с одинаковыми псевдонимами. 

TC – temperature coefficient, ТС1 – это 
линейный температурный коэффициент. 
Температурный коэффициент характе-

ризует процентное изменение абсолютной 
величины номинала компонента при изме-
нении температуры окружающей среды 
на 1°С. 

 
Температурный анализ. 

Temperature (Sweep) 
 
 15. Получить зависимости АЧХ для 

разных температур. 
 15.а. Создать новый профиль моде-
лирования. 
 15.б. Выбрать тип анализа AC Sweep, 
настроить параметры для съема АЧХ. 
 15.в. В Options выбрать Temperature Рис. 80. 

 11.з. Изменить масштаб оси Y на логарифмический.16 
 11.и. Сохранить графики шумов резисторов в заготовке отчета.5 

12. Открыть выходной файл (Output File) 4 найти и скопировать в заго-
товку отчета раздел с директивами анализа (Analysis directives). 

3
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(Sweep) и задать параметры в соответствии с п. 4 лабораторного задания, 
пример см. рис. 82. 

 

 
Рис. 81. Редактирование spice-модели емкости Cbreak 

 

Температура в PSpice измеряется в градусах Цельсия, за комнатную 
температуру в PSpice A/D принята величина 27oC . 

Если выбрать опцию Run the simulation at the temperature –
 моделирование будет выполнено для одной температуры. 

 

 
Рис. 82. Настройка частотного анализа для различных температур (Temperature (Sweep)) 
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2
 15.г. Запустить симуляцию.

По окончанию моделирования появиться окно, в котором можно вы-

брать желаемые температуры для последующего анализа в Probe 

 15.д. Построить АЧХ каскада по напряжению. Открыть окно Add 
Traces.7 В строку Trace Expression ввести выражения для коэффициентов 
передачи по напряжению. Сохранить графики в заготовке отчета.5  Пример-

ный вид графиков показан на рис. 83. 

 15.е. Сохранить в заготовке отчете полученные графики.5
16. В PSpice A/D открыть создать окно.14 
17. Построить зависимость отношения сигнал/шум от частоты для раз-

личных температур. Открыть окно Add Traces.7 В строку Trace Expression 
ввести выражения для отношения сигнал/шум. Сохранить графики в заготов-
ке отчета.5  
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Рис. 83. АЧХ каскада для различных температур 

ирования. 
рать Paramet-

ric Sw с п. 5. лабораторного задания, 
приме

 
Температурный анализ. Parametric Sweep. Анализ эффективности 

 
19. Открыть профиль модел
20. В Options снять выбор с Temperature (Sweep) и выб
eep. Задать параметры, в соответствии 
р см. рис. 84. 
На рис. 84 задано изменение температуры до 50  до 150 C o  с шагом 

10 градусов. 
21. Запустить симуляцию. 
 

 
Рис. 84. Настройка частотного анализа для различных температур (Parametric Sweep) 

 

22. В PSpice A/D создать новое окно. 
23. Запустить анализ эффективности (Performance Analysis). Команда 

Trace>Performance Analysis или щелчок соответствующей пиктограммы па-
нели инструментов (рис. 85). 

8

9

18. Открыть выходной файл (Output File)4 найти и скопировать в заго-
товку отчета раздел с директивами анализа (Analysis directives). 

14
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После запуска анализа эффективности по оси X будет откладываться 
температура в заданном ранее диапазоне. 

В ходе анализа эффективности обрабатываются только те данные, 
которые уже имеются: полученные в результате параметрического, тем-
пературного анализа, анализа Монте-Карло или на наихудший случай, т.е. 
при наличии какой-либо параметрической переменной и возможности полу-
чить семейство характеристик. В ходе анализа эффективности, для каж-
дого значения параметра, с каждой кривой семейства, считывается заранее 
заданное с помощью целевых функций значение, например максимальное зна-
чение кривой. Затем полученные таким образом значения можно предста-
вить в зависимости от параметрической переменной в виде графика. 

24. Построить зависимость коэффициента передачи в полосе пропуска-
ния каскада от температуры. 

 

 
Рис. 85. Запуск анализа эффективности (Performance Analysis) 

 

В анализе эффективности в правой части окна Add Traces, располага-
ются не список математических функций и связующих, а Measurements 
(букв. замеры, измерения) – список целевых функций, в версии OrCAD 9.2 –
 Goal Function. С помощью поля Functions or Macros можно выбирать, что 
следуе

ских функций и операций можно использовать 
и в ан

о значения параметрической переменной. Задав выражение 

т отображать в этой части окна: целевые или математические 
функции. Часть математиче

ализе эффективности. 
С помощью целевой функции Max находиться максимум операнда для 

каждог

Открыть окно Add Traces.7 В строку Trace Expressions ввести выра-
жение Max(V(OUT)/V(IN)) – целевая функция поиска максимума характери-

стики. 
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Max(V(OUT)/V(IN)) – найдем максимум коэффициента передачи для каждой 
из температур, при условии, что верхушка АЧХ плоская – получим коэффи-
циент передачи каскада в полосе пропускания. 

25. Сохранить полученный график. 
 

 
Рис. 86. Запуск анализа эффективности (Performance Analysis) 
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5

26. В PSpice A/D создать новое окно.  
27. Запустить анализ эффективности (Performance Analysis).17 
Если запускать анализ эффективности через меню Trace, то можно 

воспользоваться помощью мастера анализа эффективности (Performance 

Analysis Wizard). 

28. Построить зависимость ширины полосы пропускания каскада от 
температуры. Открыть окно Add Traces.7 В строку Trace Expressions ввести 
выражение Bandwidth(V(OUT)/V(IN),3) – целевая функция вычисления поло-

сы пропускания по уровню 3 дБ. 
29. Сохранить полученный график.5 
30. В PSpice A/D создать новое окно.14 
31. Запустить анализ эффективности (Performance Analysis).17 
32. Построить зависимость отношения сигнал/шум каскада в полосе про-

пускания от температуры. Открыть окно Add Traces.7  В строку Trace Expres-
sions ввести выражение YatX(DB(V(OUT)/V(ONOISE)),10k) – целевая функция, 

которая возвращает значение Y для указанного X. С помощью целевой функции 

YatX найдем отношение сигнал/шум на частоте 10 кГц для каждой из темпе-

ратур. Частота 10 кГц лежит в пределах полосы пропускания каскада. 

33. Сохранить полученный график.5 
34. Открыть выходной файл (Output File)4 найти и скопировать в заго-

товку отчета раздел с директивами анализа (Analysis directives). 
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Обработка экспериментальных данных 
 
Проанализировать характеристики. Определить элемент, вносящий 

наибольший вклад в общие шумы каскада. Определить пассивный элемент, 
вносящий наибольший вклад в общие шумы каскада. Определить вид шума и 
источник, в транзисторе вносящий наибольший вклад в суммарный шум 
транзистора. 

 
Содержание отчета 

 
Цель работы, исходная схема, результаты подготовки к работе (расчет 

номинала емкости, исходные соотношения и пояснения к расчетам), резуль-
таты анализа), скриншоты всех используемых в работе схем выполненных в 
OrCAD Capture, графики всех полученных характеристик и зависимостей, 
выводы по работе. 

 
Контрольные вопросы 

 
1. Какие элементы схемы являются основными источниками шумов? 
2. Физическая природа шумов радиоэлектронных компонентов. 
3. Какой спектр имеют шумы радиоэлектронных компонентов? 
4. Какие модели используются в PSpice для учета шумовых свойств 

компонентов? 
5. Как называется тип анализа, используемый в OrCAD для исследова-

ния шумовых свойств схемы? 
6. Какие параметры необходимо указать для проведения анализа шумов 

в PSpice? 
7. Какое влияние оказывает температура на шумы радиоэлектронных 

компонентов? 
8. Какое влияние оказывает температура на работу усилительного каскада? 
9. Какие параметры необходимо указать для проведения температурно-

го анализа в PSpice? 
10. Как в PSpice задаются ТКС и ТКЕ? 
11. Почему для температурного анализа используются компоненты из 

библиотеки BREAKOUT.OLB? 
12. Для чего в данной работе использовался анализ эффективности 

(Performance Analysis)? 
13. Как в PSpice обозначаются шумы компонентов? 
14. Что и как сделали и получили в лабораторной работе? 
15. Какие целевые функции использовались в работе? 
16. С помощью какой функции в PSpice вычисляются децибелы? 
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ЛАБОРАТОРНАЯ РАБОТА №4 
Параметрическая оптимизация, анализ чувствительности и ис-

следование влияния разброса параметров элементов 
на характеристики схемы 

 
Цель работы 

 
Освоение методик учета влияния разброса внутренних параметров ра-

диоэлектронных компонентов на характеристики схем с помощью средств 
САПР OrCAD. 

Изучение применения метода приращений, метода Монте-Карло и ме-
тода расчета на наихудший случай, знакомство с методикой параметрической 
оптимизацией в среде OrCAD на примере усилительного каскада построен-
ного на основе схемы включения биполярного транзистора с ОЭ со стабили-
зацией тока базы. 

 
Основные теоретические положения 

 
Влияние разброса параметров элементов. Чувствительность 
Ни один параметр элемента РЭС не может быть реализован со значени-

ем, в точности равным номинальному. На отклонения будут влиять техноло-
гические погрешности изготовления самого элемента, разброс параметров 
материалов, из которых он выполнен, а также условия эксплуатации (старе-
ние элемента, температура, влажность и т. п.). 

Следовательно, параметры элементов РЭС есть случайные величины с 
определенными статистическими характеристиками. Наличие разброса пара-
метров элементов будет вызывать изменения выходных характеристик РЭС. 

С помощью компьютерного моделирования можно еще на стадии про-
ектирования решать проблему учета влияния разброса параметров элементов, 
в общем случае охватывающую целый комплекс задач анализа и синтеза. 

В данной лабораторной работе будет решаться задача допускового ана-
лиза, заключающаяся в определении возникающих допусков выходных па-
раметров, когда заданы структура устройства, его номинальные параметры, а 
также допуски номиналов внутренних параметров. Данная задача решается, 
когда устройство полностью спроектировано и необходимо лишь проанали-
зировать влияние разброса параметров для оценки изделия при выпуске его в 
серию и необходимости введения подстроечных элементов. 

Задачу допускового анализа можно решать с использованием коэффи-
циентов чувствительности, анализа на наихудший случай и анализа Монте-
Карло.

В общем случае под чувствительностью понимают реакцию схемы на 
малое изменение ее внутренних параметров. 
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Чувствительность позволяет: 
● понять, как вариация кого-либо параметра элемента влияет на отклик 

цепи и найти те элементы, отклонения параметров которых от номинальных 
приводит к наибольшему отклонению выходных параметров схемы; 

● сравнить качество различных цепей имеющих одинаковый отклик 
при номинальных параметрах; 

● определяет градиент функции, который используется при оптимиза-
ции схемы и анализе на наихудший случай. 

Для численной оценки чувствительности используют абсолютный ко-
эффициент чувствительности (коэффициент влияния) – количественная оцен-
ка изменения выходного параметра y j  при заданном изменении параметра xi : 

dy
A j

ji  . 
dxi

В качестве выходного параметра в общем случае может использоваться 
функция качества, а в качестве xi  любой внутренний или внешний параметр. 

Коэффициент относительной чувствительности вычисляется по формуле: 
X 0

i
dy

S j
ji  Y d0

 , 
j xi

где X 0
i  – номинальное значение параметра элемента; 

 Y 0
j  – номинальное значение характеристики каскада; 

 dy j  и dxi  – отклонения характеристики и номинала элемента. 

Метод приращений 
Наиболее простым методом оценки чувствительности является метод 

приращений, основанный на численном дифференцировании. В этом ме-
тоде коэффициент чувствительности j-го выходного параметра к измене-
нию i-го внутреннего параметра определяется по выше приведенным фор-
мулам для Aji  и S ji . 

Сначала производят расчет выходных параметров в номинальном 
режиме. Затем производят n вариантов расчета, в каждом из которых дает-
ся отклонение dx 0

i  от номинального значения Xi  только одному из внутрен-
них параметров xi , и вычисляют коэффициенты чувствительности. 

Метод основан на линейном приближении зависимости S ji , что обуслав-

ливает его невысокую точность. Увеличить точность можно выполняя для каж-
дого внутреннего параметра xi  два варианта расчета путем задания отклонения 
dxi  в обе стороны от номинала. Кроме того, обычно неизвестны соображения 
по выбору оптимального значения отклонения dxi . В большинстве практиче-

ских случаев точность оказывается достаточной при  0,25X d0
i ix  0,25Xi . 0
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Наихудший случай 
Расчет на наихудший случай является простейшим видом определения 

разброса выходных параметров устройства без оценки плотности распреде-
ления этих параметров. Получаемые с помощью этого расчета оценки сильно 
завышены, что и определяет название метода. 

Наихудший случай соответствует такой ситуации, когда параметры всех 
элементов имеют максимальные по величине и такие по знаку отклонения, при 
которых возникает наибольшее отклонение выходной характеристики. 

Величину максимальных отклонений внутренних параметров задает 
разработчик, и обычно она принимается равной допуску на номинал элемен-
та, а знак отклонения определяется в ходе анализа чувствительности. 

Анализ проводиться из предположения, что знаки коэффициентов чув-
ствительности остаются неизменны во всей рассматриваемой области изме-
нений внутренних параметров. Кроме того, как и в методе приращений, 
предполагается отсутствие сильных корреляционных связей между отклоне-
ниями параметров отдельных элементов. 

В расчете на наихудший случай наибольший интерес представляют две 
ситуации: наихудший случай в меньшую (Low) и большую сторону (Hi), т.е. 
уменьшение или увеличение выходного параметра. 

В общем случае алгоритм расчета на выбранный (Low или Hi) наихуд-
ший случай содержит следующие шаги: 

● анализ чувствительности и определение знаков коэффициентов чув-
ствительности; 

● присвоение внутренним параметрам самых неблагоприятных значений; 
● расчет схемы и определение выходного параметра для наихудшего 

случая. 
В случае наличия большого числа корреляционных связей между внут-

ренними параметрами и при нелинейных зависимостях выходных парамет-
ров от внутренних, расчет на наихудший случай может дать ошибочную 
оценку. Кроме того расчет на наихудший случай не позволяет оценить веро-
ятность наступления этого, самого неблагоприятного, случая, которая как 
правило, низка. 

Монте-Карло 
Для точной оценки влияния разброса параметров элементов на выход-

ные характеристики устройства необходимо использовать методы статисти-
ческого моделирования, наиболее известный и распространенный из которых 
является метод Монте-Карло. 

По своей сути этот метод аналогичен натурному макетированию, однако 
вместо изготовления макета из элементов с разбросом используется генерация 
вектора случайных параметров с заданными статистическими характеристиками. 

Алгоритм анализа Монте-Карло функционирует следующим образом: 
1. Выполняется генерация случайной реализации вектора внутренних 
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парам  этом каждая компонента вектора генерируется с 
соотв

полоса пропускания и т. д.). 

льшого 
объем

истик и 
парам

е расчета на наихудший 
случа

 в анализе Bias Point. 

уле PSpice Advanced Analysis который по сравнению с 
PSpic
ки и о

раметрическая оптимизация 

е с применением коэффициентов чувствительности условного 
экстре а или максимума) некоторой вспомогательной функции, 
назыв

ие этапы: 

-
мальн

етров устройства, при
етствующими статистическими характеристиками. 
2. Проводится моделирование схемы с данным вектором параметров и 

определяется реализация выходных характеристик и вычисляются оценки 
выходных параметры (коэффициент передачи, 

3. Заданное число раз повторяются шаги 1 и 2. Число повторений зави-
сит от требуемой точности статистического моделирования. 

Метод Монте-Карло при высокой точности требует очень бо
а испытаний, однако уже при 1000 испытаниях обеспечивается точ-

ность порядка 1 %, что вполне достаточно для практики. 
4. По найденной совокупности реализаций выходных характер
етров выполняется их статистическая обработка. Например, определя-

ется математическое ожидание, дисперсия, их доверительные интервалы, 
границы полей допусков и т. д. 

5. По полученной совокупности реализаций выходных параметров 
строятся гистограммы распределения. 

Анализ методом Монте-Карло и расчет на наихудший случай в OrCAD 
PSpice A/D доступны как опции анализов AC Sweep, DC Sweep и Time Do-
main. Анализ чувствительности выполняется в ход

й, его результаты доступны в выходном файле. Как опция, анализ чув-
ствительности для статического режима доступен

Кроме того анализ чувствительности и метод Монте-Карло можно вы-
полнять в мод

e A/D предоставляет более широкие и наглядные возможности настрой-
бработки результатов по данным видам моделирования. 
Па
Параметрическая оптимизация относится к методам синтеза и представ-

ляет собой процедуру определения такой совокупности внутренних параметров 
РЭС, при которой заранее выбранные выходные параметры принимают наи-
лучшие возможные значения. 

В основе методов параметрической оптимизации лежат способы, осно-
ванные на поиск

мума (минимум
аемой целевой функцией. При этом целевая функция есть функция от до-

пусков на параметры. 
Полное решение задачи проектирования РЭС методами параметрической 

оптимизации включает следующ
● моделирование устройства; 
● составление целевой функции с выбором тех или иных критериев ка-

чества проектируемого устройства; 
● минимизация (максимизация) целевой функции для получения опти
ых внутренних параметров устройства, при этом, как и в задачах анали-
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за влияния разброса параметров элементов, неоднократно решается задача ана-
лиза схемы. 

В лабораторной работе рассматривается учебный пример, заключающийся 
в автоматизированном подборе параметров элементов схемы усилительного кас-
када, для получения заданного режима работы каскада по постоянному току. 

Параметрическая оптимизация в OrCAD выполняется в модуле PSpice 
Advanced Analysis. 

Подготовка к работе 
 

Ознакомиться с целями и содержанием лабораторной работы. 

ание или опрос для допуска к лабораторной 
работ

раметры схемы по Приложению 2 и 
лабор

блио-
теки т

. таб. 10 и 11). 
В кач ьзовать: коэффициент передачи кас-
када п

ора в схеме с ОЭ. Величину отклонения пара-
метро

Таблица 10 
 

Относительная чувствительность коэффициента передачи каскада по напряжению, 
в полосе опусканияпр  к изменению параметров компонентов 

 

Компонент Номинал dx   дБ  дБ  dK0 ,дБi K0 ,  K0 ,  

R_R1 (кОм) 13,5 1,35 ,191 36 36,208 0,017 
R_R2 (Ом) 26 2,6 … …  
C_C3 (мФ) 1 0,1 … …  
C_C4 (мФ) 1 0,1 … …  

BF_ Q 229,798 22,98 … …  
… … … … …  

S  K0 ,i

4,053Е-03
… 
… 
… 
… 
… 

Изучить теоретические сведения к работе. Дополнительная литература 
для подготовки см. [1, 2, 9, 11]. 

Заготовить таблицу для расчета коэффициентов чувствительности. 
Пройти входное тестиров
е. 
Исходная схема для анализа, па
аторной работе №2. 
 

Лабораторное задание 
 

1. Собрать в OrCAD Capture анализируемую схему используя би
ранзистора *.lib и *.olb созданные в PSpice Model Editor. 
2. Снять АЧХ каскада. С помощью метода приращений произвести 

расчет коэффициента чувствительности характеристик каскада к разбросу 
параметров элементов. Результаты представить в таблицах (см

естве характеристик каскада испол
о напряжению, в полосе пропускания и ширину полосы пропускания 

АЧХ по уровню 3дБ. В качестве параметров элементов использовать номи-
налы сопротивлений и емкостей, входящих в схему, а так же коэффициент 
усиления тока базы транзист

в принять равной 10% от номинала. 
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Таблица 11 
 

Относительная чувствительность ширины полосы пропускания каскада к 
изменению параметров компонентов 

 

Компонент Номинал xi  f ,кГц  f ,кГц d f ,кГц   

R_R1 (кОм) 13,5 1,35 987,15666 986,1674 0,98926 
… … … … …  

 f ,iS

0,009893 
… 

 
2. Произвести анализ влияния разброса параметров радиокомпонентов на 

характеристики схемы при помощи статистического анализа по методу Монте-
Карло и расчет наихудшего случая. Задать всем сопротивлениям, емкостям и 
коэффициенту усиления тока базы транзистора в схеме с ОЭ допуск: для пас-
сивных компонентов – 10 %, для коэффициента усиления тока базы – 25%. 

2.1. Метод Монте-Карло. 
В качестве выходной переменной использовать напряжение на выходе 

каскада, тип распределения для номиналов элементов выбрать равномерным, 
число статистических испытаний («прогонов») установить не менее 200. 

Построить АЧХ каскада для всех «прогонов» анализа Монте-Карло. 
Построить гистограммы статистического распределения коэффициента пере-
дачи и ширины полосы пропускания АЧХ. 

2.2. Расчет на наихудший случай. 
В качестве выходной переменной использовать напряжение на выходе 

каскада. Произвести расчет и построить АЧХ каскада для направления изме-
нения параметров компонентов Hi (положительное приращение) и Low (от-
рицательное приращение). Найти отклонения ширины полосы пропускания и 
коэффициента передачи в полосе пропускания для наихудшего случая лю-
бым возможным способом. 

3. По выходным характеристикам транзистора, полученным в лабора-
торной работе №2 выбрать новую рабочую точку и произвести параметриче-
скую оптимизацию каскада с помощью модуля PSpice Advanced Analysis 
(в OrCAD 9.2 – модуль PSpice Optimizer). Оптимизацию производить для ра-
бочей точки с неизвестным заранее током базы Iб0 , опираясь на значения на-
пряжения Uкэ0  и тока Iк0 . 
 

 
Подготовка схемы 

 
1. Загрузить графический редактор схем – программный модуль Or-

CAD Capture (CIS). 
2. Создать проект (Analog or Mixed A/D) и средствами Capture ввести 

схему, соответствующую своему варианту, в ЭВМ. 

Порядок выполнения и рекомендации 
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Источник входного сигнала – VSIN, источник питания – VDC. 
Обозначить входы и выходы схемы, присвоив псевдонимы соответст-

вующим цепям.   Вход обозначить как in, а выход – out. 
3. Параметры источника VSIN: смещение – 0, амплитуда колебания – 0, 

частота сигнала – из диапазона, в пределах которого АЧХ каскада по напря-
жению линейна, параметр AC задать равным Uвх  и отобразить на схеме 
(см. пп. 5.а и 5.г лабораторной работы №2, часть 2). 

5. Создать новый профиль моделирования. Выбрать тип анализа –
 AC Sweep, настроить параметры для съема АЧХ. 

6. Запустить симуляцию. 
7. Построить АЧХ каскада по напряжению. Открыть окно Add Traces. 

В строку Trace Expression ввести выражения для коэффициентов передачи 
по напряжению. Сохранить графики в заготовке отчета. 

 8. Найти коэффициент передачи каскада по напряжению, в полосе про-
пускания и ширину полосы пропускания АЧХ по уровню 3дБ. 
 8.а. Открыть окно Evaluate Measurement (вычисление целевых функ-
ций). Команда Trace>Evaluate Measurement…, или соответствующая пикто-
грамма панели инструментов (рис. 87). 
 8.б. В строку Trace Expression ввести MAX(DB(V(OUT)/V(IN))). 

 

 
Рис. 87. Расчет целевых функций 

 

 8.в. Открыть окно Evaluate Measurement.  
 8.г. В строку Trace Expression ввести BANDWIDTH(V(OUT)/V(IN),3). 

Окно Evaluate Measurement (рис. 88) открываемое командой (рис. 87), 
аналогично окну Add Traces, но в правой части окна, как и в анализе эффек-
тивности, находиться список целевых функций. В OrCAD 9.2, команда для 
расчета целевых функций Trace>Eval Goal Function. 

В версиях OrCAD 10.5 и старше результаты вычисления целевых 
функций можно отображаются в виде таблицы под областью построения 
(рис. 89), если таблица не появилась, выполнить команду View>Measurement 
Results (рис. 89). 
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Рис. 88. Окно Evaluate Measurement. Расчет целевых функций 

 

 8.д. Зафиксировать полученные значения коэффициента передачи и 
ширину полосы пропускания в заготовке отчета. 
 

 
Рис. 89. Отображение результатов вычислений целевых функций в табличном виде 

 

Результаты расчета целевых функций можно отобразить на графике, 
для этого выполнить команду Tools>Options…, в открывшемся диалоговом 
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окне Probe Settings поставить флажок Display Evaluation. С данной уста-
новкой, при каждом расчете целевых функций будет построен график с 
метками и результатами вычисления, соответствующими введенной целе-
вой функции (рис. 90). 

 

 
Рис. 90. Отображение результатов вычислений целевых функций на графике 
 

Анализ чувствительности методом приращений 
 

 9. С помощью метода приращений произвести расчет коэффициента 
чувствительности характеристик каскада к разбросу параметров элементов. 
 9.а. Увеличить параметр какого-либо элемента на 10%. Повторить дей-
ствия по пп. 6, 7, 8. Результаты внести в таблицу (см. табл. 10 и 11). 

Если в окне Simulation Settings, на закладке Probe Windows включить оп-
цию Last plot, то пересчет АЧХ и целевых функций будет происходить автома-
тически. 
 9.б. Присвоить выбранному в п. 9.а элементу значение параметра на 
10% меньше номинального. Повторить действия по пп. 6, 7, 8. Результаты 
внести в таблицу (см. табл. 10 и 11), затем вернуть параметру номинальное 
значение. 
 9.в. Повторить действия по пп. 9.а и 9.б для всех элементов схемы, 
кроме источников энергии и заполнить таблицу числовыми значениями. 

 9.в.1. Для биполярного транзистора приращения выполнять для па-
раметра spice-модели транзистора BF – коэффициент усиления тока базы в 
схеме с ОЭ. 

 9.в.2. Для изменения параметров spice-модели транзистора выбрать 
транзистор, затем команда Edit>Pspice Model или щелкнуть правой кнопкой 
и из контекстного меню выбрать Edit Ppice Model. 

 9.в.3. В открывшемся редакторе моделей (PSpice Model Editor), най-
ти и изменить параметр BF spice-модели. Сохранить изменения. 
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Задание допусков параметров элементов 
 
10. Вернуть всем элементам номинальные параметры. 
11. В свойствах компонентов задать всем сопротивлениям и емкостям 

допуск номинала равный 10%. 
Выделить все сопротивления и емкости последовательными щелчками 

мыши удерживая клавишу Ctrl, затем открыть редактор свойств компонентов, 
команда Edit>Properties (Ctrl+E). В появившемся окне редактора свойств, 
ввести параметр TOLERANCE для всех компонентов равный 10 % (рис. 91). 

 

 
Рис. 91. Задание параметра TOLERANCE 

 

 12. Задать разброс для коэффициента усиления тока базы транзистора. 
 12.а. Выделить транзистор, затем команда Edit>Pspice Model или 
щелкнуть правой кнопкой мыши и из контекстного меню выбрать Edit Ppice 
Model. 
 12.б. В тексте spice-модели транзистора, после BF=… задать отклоне-
ние DEV=25% (рис. 92), сохранить изменения. 
 

 
Рис. 92. Редактирование spice-модели транзистора 

 

В анализе Монте-Карло и расчете наихудшего случая в PSpice A/D 
учитываются только элементы и параметры с заданным допуском. 
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Расчет на наихудший случай 
 

 
 13. Произвести расчет на наихудший случай. 

 13.а. Создать новый профиль моделирования. Выбрать тип анализа –
 AC Sweep, настроить параметры для съема АЧХ. 
 13.б. В разделе окна Options установить флажок Monte Carlo/Worst-
case, затем выбрать опцию Worst-case/Sensitivity. В качестве выходной пе-
ременной использовать напряжение на выходе каскада (Output variable –
 V(out)) (рис. 93). 
 

 
Рис. 93. Настройка анализа на наихудший случай 

 

 13.в. Задать направление изменения выходной характеристики Hi. 
Для выбора направления приращения необходимо в окне настройки 

Worst-case/Sensitivity щелкнуть More Settings, в окне Monte Carlo/Worst-
case Output File Options в разделе Worst-Case direction поставить флажок Hi. 
 13.г. Запустить симуляцию. 
 13.д. Построить АЧХ каскада по напряжению для всех прогонов. От-
крыть окно Add Traces. В строку Trace Expression ввести выражения для 
коэффициентов передачи по напряжению. Сохранить графики в заготовке 
отчета. 
 13.е. Найти отклонения ширины полосы пропускания и коэффициента 
передачи в полосе пропускания (в децибелах) для наихудшего случая любым 

Параметры, имеющие опцию DEV, получают случайный разброс зна-

чений в пределах указанной в процентах величины. Параметр TOLERANCE в 

редакторе свойств назначает DEV для пассивных компонентов из библио-

теки ANALOG.OLB. Для пассивных компонентов из библиотеки 

BREAKOUT.OLB разброс задается редакцией spice-модели компонента, вво-

дом и заданием DEV. 

3
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возможным способом. Можно воспользоваться трассировкой или вычислить 
соответствующие целевые функции. Пример показан на рис. 94. 
 13.ж. Сохранить полученные графики и числовые параметры. 
 13.з. Задать направление изменения выходной характеристики Low и 
повторить действия по пп. 13.г, 13.д, 13.е, 13.ж. 
 

 
Рис. 94. Результаты анализа на наихудший случай 

 

В ходе расчета наихудшего случая определяются коэффициенты чув-
ствительности для выходной переменной (Output variable), при этом при-
ращения для параметров элементов находятся по формуле: 
dxi i X 0 RELTOL , где X  –0

i  номинальное значение параметра элемента, 
RELTOL – относительная точность расчета, задается через опции окна 
Simulation Settings и по умолчанию равна 0,001. Результаты анализа чувстви-
тельности доступны в выходном файле. 

Приращения параметров элементов для наихудшего случая принимаются 
равными заданному допуску, в нашем случае параметру TOLERANCE (DEV). 

 
Анализ Монте-Карло 

 

 14. Произвести анализ Монте-Карло. 
 14.а. Создать новый профиль моделирования. Выбрать тип анализа –
 AC Sweep, настроить параметры для съема АЧХ. 

5

 13.и. Открыть выходной файл (Output File)4 найти и скопировать в за-
готовку отчета раздел с директивами анализа (Analysis directives). 

3
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 14.б. В разделе окна Options установить флажок Monte Carlo/Worst-
case, затем выбрать опцию Monte Carlo. В качестве выходной переменной 

ut)), тип 

ий («прогонов») установить 
е менее 200 (Number of runs ≥ 200). Пример показан на рис. 95. 

 

использовать напряжение на выходе каскада (Output variable – V(o
распределения для номиналов элементов выбрать равномерное (Use distribu-
tion – Uniform), число статистических испытан
н

 
Рис. 95. Настройка анализа Монте-Карло 

 

В поле Random number seed задается начальное значение генератора 
случайных чисел, оно может принимать нечетные значения в диапазоне от 1 
до 32767. По умолчанию, начальное значение устанавливается в 17533. При 
одинаковых значениях результаты анализа Монте-Карло будут повторяться. 

В поле Output Variable указывается имя выходной переменной, подле-
жащей статистической обработке 

В выпадающем меню Use distribution можно выбрать стандартный 
закон распределения случайных величин: 

Uniform – равновероятное распределение на отрезке (–1,+1); 
Gauss – распределение Гаусса (нормальное) на отрезке (–1,+1) с нуле-

вым средним значением и среднеквадратичным отклонением СКО=0,25. 
Кроме того, можно задать нестандартный закон распределения слу-

чайных величин, щелкнув по клавише Distributions. 
 14.в. Запустить симуляцию. 

Для анализа Монте-Карло случайные значения параметров компонен-
тов рассчитываются по формуле: x X 0

i i  1    , где X  –0
i  номинальное 

значение параметра элемента,   – допуск параметра элемента, в нашем 
случае TOLERANCE (DEV),   – центрированная случайная величина в диапа-
зоне  1, 1 , формируема генератором случайных чисел в соответствии с 

заданным законом распределения. 

2
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 14.г. Построить АЧХ каскада по напряжению для всех прогонов. От-
крыть окно Add Traces. В строку Trace Expression ввести выражение для 
коэффициента передачи по напряжению.  
 14.д. Изменить параметры отображения графиков, включив запрет по-
каза символов. Команда Tools>Options…, в открывшемся диалоговом окне 
Probe Settings в разделе Use Symbols поставить флажок Never (рис. 96). 
 14.е. Сохранить полученные графики АЧХ в заготовке отчета. 

 

 
Рис. 96. Окно Probe Settings. Запрет показа символов графиков 

5

 14.ж. Построить гистограммы статистического распределения коэффи-
циента передачи и ширины полосы пропускания АЧХ. 

 14.ж.1. В PSpice A/D создать новое окно.14 Запустить анализ эффек-
тивности (Performance Analysis).17 

 14.ж.2. Открыть окно Add Traces.7 В строку Trace Expressions вве-
сти выражение MAX(DB(V(OUT)/V(IN))). 

 14.ж.3. Добавить в текущем окне еще одну систему координат (об-
ласть построения).19 Открыть окно Add Traces.7 В строку Trace Expressions 
ввести выражение BANDWIDTH(V(OUT)/V(IN),3)). 
 14.з. Сохранить полученные гистограммы и числовые параметры.5 
Пример показан на рис. 97. 

Числовые параметры, полученные в результате анализа Монте-Карло: 

n samples – число прогонов, n divisions – число столбцов гистограммы; mean, 
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maximum, minimum, median – среднее (математическое ожидание), макси-
мум, минимум и медиана полученного распределения значений целевой функ-
ции; 10th%ile, 90th%ile – десяти и девяностопроцентные квантили распре-
деления; sigma – среднеквадратическое отклонение. 

 

 
Рис. 97. Гистограммы анализа Монте-Карло 

 

 14.и. Открыть выходной файл (Output File) найти и скопировать в за-
готовку отчета раздел с директивами анализа (Analysis directives). 

 
Параметрическая оптимизация. Создание целевых функций 

для оптимизации рабочей точки 
 
15. По выходным характеристикам транзистора, полученным в лабора-

торной работе №2 выбрать новую рабочую точку неизвестным заранее током 
базы IБ0  (рис. 98) и зафиксировать значения напряжения UКЭ0  и тока IК0 . 

Значения напряжения U  КЭ0 и тока IК0  можно определить, трассируя 
график гиперболы мощности или просто наводя курсор мыши на рабочую 
точку. 

16. Создать новый профиль моделирования. Выбрать тип анализа –
 Time Domain. Параметры анализа Run to time и Start saving data after за-
дать таким образом, чтобы исключить отображение начального момента 
времени. Амплитуду VAMPL задать равной 0. 
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Рис. 98. Выбор новой рабочей точки с неизвестным током базы 

 

 

 
Рис. 99. Добавление области построения 

 17. Построить графики тока и напряжения коллектора. 
 17.а. Добавить в текущем окне еще одну систему координат (область 
построения).19 
 17.б. Построить график тока коллектора в одной области, а напряжения 
коллектора в другой (рис. 99). 
 17.в. Включить трассировку 10 и поставить на построенных графиках 
метки 11 с координатами. Отредактировать метки так, чтобы отображалось 
только значение по оси Y (рис. 99). Режим редактирования меток запуска-

ется двойным щелчком правой клавиши мыши по метке. 

 17.г. Сохранить полученный результат в заготовке отчета. 
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18. Рассчитать целевые функции MAX для напряжения и тока коллек-
тора, VC и IC. 

Для проведения параметрической оптимизации в OrCAD необходимо 
предварительно создать профиль моделирования и промоделировать схему, а 
также рассчитать целевые функции, по которым собственно и будет произ-
водиться оптимизация. Однако в OrCAD не предусмотрен расчет целевых 
функций для режима анализа по постоянному току Bias Point и не преду-
смотрено использование в качестве целевых функций просто кого-нибудь то-
ка или напряжения, поэтому для оптимизации рабочей точки приходиться 
идти окольными путями и производить дополнительные манипуляции. 

 
Параметрическая оптимизация в PSpice Advanced Analysis 

 
 19. Произвести параметрическую оптимизацию для рабочей точки с 

параметрами определенными в п. 15. 
 19.а. Запустить модуль PSpice Advanced Analysis (Optimizer). Команда 
PSpice>Advanced Analysis>Optimizer (рис. 100). 

 

 
Рис. 100. Запуск модуля параметрической оптимизации PSpice Advanced Analysis 

 

 19.б. В отрывшемся модуле оптимизации, щелкнуть по ячейке таблицы 
Parameters содержащей текст «Click her to import a parameters…» (рис. 101). 
В открывшемся окне Parameters Selection выбрать компоненты параметры, 
которых будут оптимизироваться, в нашем случае это сопротивления, за-
дающие рабочую точку (рис. 101). 

В таблице Parameters отобразятся исходные (Original), минимальные 
(Min) и максимальные (Max) параметры компонентов. Значения Min и Max 
устанавливают диапазон, в котором будут меняться параметры, эти зна-
чения по умолчанию рассчитываются модулем оптимизации: Min как 10% 
от Original, а Max – Original10. Min и Max можно отредактировать 
вручную, на основе собственной оценки. 

18
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Рис. 101. PSpice Advanced Analysis. Выбор компонентов для оптимизации 

 

 19.в. Щелкнуть по ячейке таблицы Specifications содержащей текст 
«Click her to import a measurements…» (рис. 102). В открывшемся окне Im-
port measurements выбрать целевые функции (рис. 102). 

 

 
Рис. 102. Выбор целевых функций 
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 19.г. В столбцах Max и Min (рис. 103) таблицы Specifications задать 
ограничения для целевых функций, так, чтобы указанный диапазон включал 
параметры новой рабочей точки, полученные в п. 15. 
 19.д. Запустить оптимизацию (рис. 103). 

 

 
Рис. 103. Задание диапазона значений целевых функций 

 

 
Рис. 104. Выбор и задание параметров для проведения округления значений параметров 

компонентов к значениям, соответствующим стандартным рядам номиналов 
 

В показанном на рис. 103 примере, заданы диапазоны значений для ра-
бочей точки p-n-p транзистора: UКЭ0  17 В , IК0  30мА  (рис. 103). Диа-
пазон значений целевых функций должен быть с одной стороны узок, чтобы 
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полученные цифры удовлетворяли поставленной задаче, с другой стороны 
сужение диапазона может привести к невозможности достижения указан-
ных значений целевых функций. 
 19.е. По завершению оптимизации поменять метод оптимизации с 
Modified Least Squares Quadratic (LSQ) на Discrete (рис. 104). Выбрать для 
номиналов сопротивлений 1% ряд точности (рис. 104). 

Modified Least Squares Quadratic – модифицированный метод наи-
меньших квадратов. Discrete (дискретный) – метод используется в конце 
оптимизации для округления значений параметров компонентов к значени-
ям, соответствующим стандартным рядам номиналов. 
 19.ж. Запустить оптимизацию (рис. 103). 
 19.и. Сделать и сохранить в заготовке отчета скриншот окна PSpice Ad-
vanced Analysis (Optimizer). 
 

Параметрическая оптимизация. Оценка результатов 
 
20. В OrCAD Capture продублировать исходную схему усилительного 

каскада. Скопировать и перенести обычными средствами Windows новые 
значения сопротивлений в сдублированную схему. 

 

 
Рис. 105. Результаты анализа двух схем по постоянному току 

(до и после процедуры оптимизации)  
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21. Установить амплитуду входного сигнала VAMPL равным Uвх . 
Произвести анализ исходной схемы и схемы с оптимизированными парамет-
рами по постоянному току, в частотной области и во временной области, по-
лучить и сохранить в заготовке отчета соответственно: скриншот (пример 
см. рис. 105), АЧХ по напряжению и эпюры гармонического напряжения на 
выходах обеих схем. АЧХ и эпюры для двух схем построить в одной коорди-
натной сетке частот и времен соответственно (для удобства сравнения). 

 
Обработка экспериментальных данных 

 
Рассчитать на основе полученных данных коэффициенты чувствитель-

ности максимума АЧХ и ширины полосы пропускания к изменению пара-
метров элементов. Определить элементы с наибольшей и наименьшей чувст-
вительностью. 

Проанализировать характеристики и полученные статистические дан-
ные. В выводах привести числовые характеристики, полученные в ходе ана-
лиза по методу Монте-Карло и расчета на наихудший случай. 

Проанализировать, лежат ли значения, полученные в результате анали-
за по методу Монте-Карло в пределах диапазона значений полученных в рас-
чете на наихудший случай. 

Проанализировать результаты параметрической оптимизации на пред-
мет улучшения-ухудшения характеристик усилительного каскада. 

 
Содержание отчета 

 
Цель работы, исходная схема, скриншоты всех используемых в работе 

схем выполненных в OrCAD Capture, графики всех полученных характери-
стик и зависимостей, гистограммы распределения, результаты расчета целе-
вых функций, таблицы приращений и чувствительностей (см. табл. 10 и 11), 
результаты оптимизации (скриншот окна PSpice Advanced Analysis) выводы 
по работе. 

 
Контрольные вопросы 

 
1. Что такое чувствительность схемы к изменениям внутренних пара-

метров? 
2. Для чего анализируют чувствительность? 
3. Суть метода приращений, преимущества и недостатки. 
4. Суть расчета на наихудший случай, преимущества и недостатки. 
5. Суть анализа Монте-Карло, преимущества и недостатки. 
6. Как в PSpice рассчитываются случайные значения параметров ком-

понентов для анализа Монте-Карло. 



 Лабораторная работа №4. Оптимизация, чувствительность, влияние разброса параметров элементов 

Контрольные вопросы
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7. Что называется параметрической оптимизацией? 
8. Какие критерии оптимизации использовались в работе? 
8. В каких режимах анализа в PSpice можно рассчитать целевые функ-

ции для параметрической оптимизации? 
9. Что и как сделали, получили в лабораторной работе? 
10. Как называется модуль программы OrCAD в котором выполняется 

параметрическая оптимизация? 
11. Какие параметры задаются в OrCAD для проведения анализа на 

наихудший случай? 
12. Какие параметры задаются в OrCAD для проведения анализа мето-

дом Монте-Карло? 
13. Как в PSpice задается допуск параметра элемента? 
14. Какие директивы анализа в PSpice задают расчет на наихудший 

случай и анализ Монте-Карло? 
15. Какие проектные процедуры выполнялись в лабораторной работе? 
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ПРИЛОЖЕНИЕ 1 
 

Варианты схем для выполнения лабораторной работы №1 
 

  

Вариант 1 Вариант 2 

  

Вариант 3 Вариант 4 

  

Вариант 5 Вариант 6 

  

Вариант 7 Вариант 8 

 



 ПРИЛОЖЕНИЕ 
ПРИЛОЖЕНИЕ 1
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Вариант 9 Вариант 10 

  

Вариант 11 Вариант 12 

  

Вариант 13 Вариант 14 

  

Вариант 15 Вариант 16 

 

 



 ПРИЛОЖЕНИЕ 
ПРИЛОЖЕНИЕ 1
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Вариант 17 Вариант 18 

  

Вариант 19 Вариант 20 

  

Вариант 21 Вариант 22 

  

Вариант 23 Вариант 24 

 



 

 

ПРИЛОЖЕНИЕ 2 
 
Схема, параметры и данные для выполнения лабораторной работы №2 

 

 
Рис. П2. Анализируемая схема 

 

Исходные данные: 
● режим работы транзистора – активный (без отсечки); 
● принимая во внимание предельно допустимые эксплуатационные 

данные транзистора и режим работы получить максимально возможный ко-
эффициент передачи по мощности; 

● модель транзистора выбрать в соответствии с номером варианта по 
табл. П2; 

● Ср = ;100мкФ  

● Uвых  – максимально возможное для данного режима работы тран-
зистора и нагрузки, Еп к= 80%U эmax ; 

● R aн =  –(кОм)  сопротивление нагрузки; 

● U bвх =  –(мВ)  амплитуда напряжения на входе; 

где a – последняя цифра зачетки (если 0, то 10a = ), 
b – номер варианта. 
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 ПРИЛОЖЕНИЕ 
ПРИЛОЖЕНИЕ 2
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Таблица П2 
 

Модели транзистора 
 

Номер Модель транзи-
Производитель 

варианта стора 
1 2PB709BRL NXP Semiconductors 
2 BC847CW NXP Semiconductors 
3 MPSW06 ON Semiconductor 
4 BCP68T1 ON Semiconductor 
5 MMBT3906 Diodes Incorporated 
6 PMBT4401 NXP Semiconductors 
7 PMBT6428 NXP Semiconductors 
8 BSP16T1 ON Semiconductor 
9 2SC4617 ON Semiconductor 
10 2DD2652 oratedDiodes Incorp  
11 BC807-40W  NXP Semiconductors
12 BCW33 NXP Semiconductors 
13 NJT4030P ON Semiconductor 
14 NJT4031N ON Semiconductor 
15 ZXTN25012EFH Diodes Incorporated 
16 2PB709ASW NXP Semiconductors 
17 BCX70K NXP Semiconductors 
18 PZT2907AT1 ON Semiconductor 
19 BCP69T1 ON Semiconductor 
20 ZUMT718 Diodes Incorporated 
21 BCW70 NXP Semiconductors 
22 PMBT3904 iconductorsNXP Sem  
23 PMSS3904 ctorsNXP Semicondu  
24 BCW69 NXP Semiconductors 
25 ZTX449 Diodes Incorporated 
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ПРИЛОЖЕНИЕ 3 
 

Схема, параметры и данные для выполнения лабораторной работы №3 
 

 
Рис. П3. Анализируемая схема 

 

Внутреннее сопротивление источника сигнала – Rвн  b 100Ом , 
где b – номер варианта. 

Остальные параметры схемы и транзистор выбрать в соответствии с 
Приложением 2. 

 
 


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Примечания 
                                                 
1 В Capture пиктограмма  или команда PSpice>Edit Simulation Profile. 
2 В Capture пиктограмма , F11 на клавиатуре или команда PSpice>Run. 
3 Пиктограмма  или команда PSpice>New Simulation Profile. 
4 В PSpice A/D пиктограмма  или команда View>Output File. 
5 Команда Window>Copy to Clipboard, затем вставить в MO Word 
6 Команда Plot>Axis Settings или двойной щелчок по оси. 
7 Пиктограмма , Insert на клавиатуре или команда Trace>Add Trace…. 
8 В PSpice A/D пиктограмма  или команда Simulation>Edit Profile…. 
9 В PSpice A/D пиктограмма  или команда Simulation>Run. 
10 Пиктограмма  или команда Trace>Cursor>Display. 
11 Пиктограмма  или команда Plot>Label>Mark. 
12 Пиктограмма , N на клавиатуре или команда Place>Net Alias…. 
13 Пиктограммы , ,  или команда PSpice>Bias Point>…. 
14 В PSpice A/D команда Window>New Window. 
15 Команда Plot>Add Y Axis или Ctrl+Y на клавиатуре. 
16 Пиктограмма  или через окно Axis Settings. 
17 Пиктограмма  или команда Trace>Performance Analysis. 
18 Пиктограмма  или команда Trace>Evaluate Measurement. 
19 Команда Plot>Add Plot To Window. 
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